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Chapter 1 l

Curtain Up

So here we are, raising the curtain to you and your new animation tool, 
ObjectDANCER™, by PaceWorks. ObjectDANCER, a multimedia authoring tool, 
offers the perfect balance between innovative, powerful object-oriented technology 
and the preservation of flow of the creative process. Any creative designer or 
multimedia developer who professionally builds animations—ranging from 
commercials, CD titles, on-line help or Internet-based animations, to lengthy 
marketing videos—knows the value of having rich tools to ease the tedious 
challenge of bringing their creativity to life. ObjectDANCER was developed to ease 
such a challenge, to close the gap left open by other authoring tools that lack the 
needed precise manipulative control over graphical objects, extensive typography, 
and audio synchronization. 

Key Features

ObjectDANCER is an author-oriented tool that includes a number of key features to 
give you added control while building animated presentations. These key features 
are summarized in the following sections so you are familiar with their availability 
before you get to deep into your learning. You can therefore prepare for your 
animation projects properly. Don’t worry if you don’t fully understand each of 
these summarized features at this point—we don’t yet expect you to. As you delve 
deeper into this manual, however, you will get full explanations for practical 
application of these features within your projects:
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• extensive file format support

• text decomposition

• time alignment

• direct audio CD import

• independent libraries

• unlimited undos/redos

• paste special

• speed control

• synchronization markers

Extensive File Format Support

ObjectDANCER supports the most popular content creation software applications, 
giving you the flexibility to create complex and impressive presentations. Files 
(objects) created in these applications can be dragged and dropped directly into an 
ObjectDANCER project window, without even opening the file. In addition, you can 
directly input text into an ObjectDANCER project.

ObjectDANCER’s output mechanisms also offer you choices of formats to output 
final projects. QuickTime movies can be created and compressed using standard 
QuickTime compressor algorithms. Projects can be outputted as Sprite or GX 
Quicktime movies. GIF89 animations can be read by Web browsers, and when 
JAVA animations are output, the project is converted to a set of JAVA applets, and 
an HTML file. Finally, a screenshot of any project at any point during its 
development can be printed or saved.
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The following diagram summarizes ObjectDANCER’s supported file formats:

Text Decomposition 

This feature allows you to break down an imported text object into smaller objects 
of the whole text object, such as letters, or words. After a text object is 
“decomposed”, you can then animate and synchronize the smaller text objects 
individually, and differently, as desired, from one another. 

Time Alignment 

With time alignment, you can select a group of objects within your project, and 
align the start and stop sequences, and then specify timing increments of the 
objects relative to one another. With this, increments between two or more dances 

INPUT OUTPUT

Image

• GIF (*.GIF files)

• JPEG (*.JPG files)

• PICT

• GX graphics or text

• rgb.sgi

• Adobe PhotoShop

• MacPaint

• QuickTime movies,
including sprite, video, or 
text tracks

Text

• direct input text

• ASCII

ObjectDANCER Projects

Sound

• AIFF

• AIFC (IMA 4:1, MACE 3:1 
MACE 6:1, µlaw 2:1)

• WAV (*.WAV files)

• AU (*.AU files)

• DigiDesign Sound 
Designer II 

• QuickTime sound tracks

MIDI files

• *.MID files

• QuickTime MIDI tracks

Audio CD 

• Drag and drop track from 
audio CD.

Static (non-animated)

• PICT

• GX

• GIF

Animated

• QuickTime

• QuickTime sprites

• QuickTime GX

• GIF89 animations

• JAVA output
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within an animation can be aligned to have equal increments between their starts 
and stops, or the objects can be aligned to all start or stop at the same time.

One example of when you might use the Time Alignment... command would be if 
you wanted to align a group of objects to move alike, and with the movements 
smoothly starting one right after another, as opposed to them all moving 
simultaneously, or sporadically. Through this feature, you have precise control of 
the timing of objects movements and how they related to one another.

Direct Audio CD Import 

ObjectDANCER allows you to directly import any previously recorded digital audio 
file, and specify the quality and compression of the audio to be played back within 
your finished animation. Before creating a movie, you’ll select a desired sample 
rate, sample size and either mono or stereo channels for the audio’s quality. In 
addition, if you have QuickTime 2.5 (or later) installed, you can select one of the 
following audio compression algorithms: IMA 4:1, MACE 3:1, MACE 6:1, or 
µlaw 2:1.

Independent Libraries 

The libraries created within ObjectDANCER projects are specifically designed to be 
project independent, meaning that the libraries or library entries can be easily 
interchanged between different projects, or even different authors. This feature is 
especially useful when creating multiple projects simultaneously and when certain 
objects are used multiple times within different project files. Since the libraries are 
not project linked, they can be easily shared with co-workers while working on 
multi-faceted projects.

Unlimited Undos/Redos 

You have unlimited “Undo/Redo” capabilities while using ObjectDANCER. Given 
the complexity of many multimedia projects, this feature becomes very handy at 
times when you realize you that you made a critical error just a few maneuvers 
back, and would otherwise have to restart you project if you were not able to undo 
your changes more than one level. An adjustable “Undo level” can be set within 
preferences.
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Paste Special 

With Paste Special, you are able to paste only a chosen attribute(s) of a particular 
object to another object or objects rather than manually updating these objects 
with a particular attribute(s) over and over again. Paste Special allows you to 
selectively choose which animated attributes (dances) should be pasted to the 
destination object(s), and which attributes should not.

One example of how you might use this feature is if you had an object that moved 
in a particular way that you especially liked and you wanted another object to 
replicate the exact movement. To do this, you would either have to recreate the 
movements manually on the second object, or through using the Paste Special... 
command, you could copy only the specific movements to the new object while 
leaving all other attributes unchanged and untouched.

Speed Control 

You can control the speed between the changes of an object’s attribute over time 
through manipulating bezier curves (curved object paths) along a graphical slope 
that indicates the speed of a change. When you flatten the slope by dragging on the 
bezier curve, the speed between the attribute’s changes are slowed; steeper slopes 
indicate quick changes.

Synchronization Markers 

Synchronization markers within both the Synchro and Audio Windows allows you 
to mark significant changes within an animation “on-the-fly” so that movements 
and audio fluctuations can be easily identified for synchronizing with each other 
later.

Systems Ready?

Before using ObjectDANCER, you’ll need to account for a few system 
configuration considerations to make sure that your Macintosh is in good shape, 
and ready to take on the intense system requirements inherent with the word 
“multimedia”. 
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Following is a summary of configuration requirements. Read the sub-sections that 
follow for further details about each requirement.

✔ An Apple Macintosh™ PowerPC, any model (or PowerPC clones), with a 
minimum of 5 megabytes (MB) of application RAM (8 MB or more 
recommended).

✔ Apple System Software 7.5 (or later) installed, which includes the following 
necessary extensions: ColorSync™ system extension and control panel, Sound 
Manager 3.2 (or later) system extension, and Sound control panel.

✔ Apple QuickDraw GX software installed, which comes packaged with System 
Software 7.5 or later (although QuickDraw GX is not automatically installed), 
OR 
Apple’s GXGraphics INIT system extension, a much lighter solution.

✔ QuickTime™ 2.1 (or later—version 2.5 recommended), which includes: 
QuickTime™ system extension, QuickTime™ PowerPlug system extension, 
QuickTime™ Musical Instruments system extension.

In addition, PaceWorks recommends the following hardware, although it is not 
required:

✔ CD-ROM drive

✔ 17” or larger monitor

✔ external speakers

Configuring Your PowerPC

ObjectDANCER was developed on and for a PowerPC (either Apple-brand or other 
brands). Although the higher-end PowerPCs offer superior speed, higher disk 
space, and larger RAM expandability capabilities, any PowerPC can run 
ObjectDANCER.

ColorSync™ System Extension, ColorSync™ Control Panel     These files are 
included/installed with System Software 7.5 (or later). They provide the color 
reproduction and color management capabilities that high-end multimedia 
hardware and software requires for color intensive printing and video projects. 
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RAM 

ObjectDANCER requires a minimum of 5 MB of application RAM to run (only if 
virtual memory is on), although allocating more memory is better. For better 
reliability, we recommend that you allocate 9 MB of RAM or more to 
ObjectDANCER, depending on how much available RAM you have. 

To allocate more memory, select the ObjectDANCER application file, and then 
select Get Info from the Finder menu. Ensure that the “Minimum size:” field has 
5000K or more entered; input 9000K or more in the “Preferred size:” field. 

Note

If your application was already open on your system, you cannot make 
memory allocation adjustments. Close the application first, and then try.

Memory Control Panel    By adjusting the memory control panel’s settings 
appropriately, you can significantly improve the performance of how 
ObjectDANCER (or other applications, for that matter) works on your Macintosh. 
The following bullets include some suggestions.

• Disk Cache - This setting sets aside RAM for quick retrieval of frequently 
accessed data on your hard drive. This setting should be kept anywhere 
between 128K and 1MB, depending on available memory.

• Modern Memory Manager - The default setting is always on. If you turn 
Modern Memory Manager off, your system will access memory in as non-
optimal way and the performance of your PowerPc will be reduced.

• Virtual Memory - This setting treats part of your hard drive as extra RAM, 
which can often be helpful. By setting virtual memory to 1 MB or more, you 
can allow a drastic reduction in RAM requirements for running 
ObjectDANCER and other PowerPC applications. If you only have 5 MB of 
RAM allocated to ObjectDANCER, you must have virtual memory on and set it 
to at least 1 MB. Note that with limited RAM, however, performance issues 
may crop up.

If you have plenty of RAM, turn virtual memory off. QuickTime (which 
you’ll read more about in a few pages) sometimes does not work well with 
virtual memory on, which would ultimately slow down your efforts in 
ObjectDANCER.
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• RAM Disk - Turn RAM disk off. This setting turns part of your RAM into a 
virtual fast hard disk—basically the opposite of virtual memory. Unless you 
have tons of extra RAM on your system, which is not usually the case for 
most of us, leave RAM disk off so more built-in RAM can be dedicated to 
ObjectDANCER or other applications.

Hard Drive 

Having a dedicated clean, fast, and roomy hard drive is certainly the most ideal of 
hard drive situations, although understandably, perhaps not the most practical 
requirement for all users. Therefore, we encourage you to assimilate this ideal as 
best possible in other ways: 

• clean up your existing hard drive

• optimize your hard drive

• partition your hard drive with an area for ObjectDANCER projects, if you have 
a large enough drive (certainly not mandatory)

There are a number of good hard drive diagnostics and repair, optimization, and 
partitioning tools out in the market or on the Internet these days to make these 
tasks simpler. We firmly recommend that you take advantage of these tools before 
working with ObjectDANCER (or other applications), so as to avoid unexpected 
hard drive problems later.

Sound Manager

The Sound Manager 3.2 (or later) system extension and the Sound control panel1 
should be installed on your system (included with the System Software 7.5 [or 
later] installed files). Sound Manager is Apple’s digital audio software that allows 
multimedia applications to play and record sounds by using an internal sound chip 
that supports 16-bit CD-quality audio. 

File Sharing

As a Macintosh user running System Software 7.5 (or later) on a network, you 
have undoubtedly already discovered the convenient File Sharing feature. While 

1. With System Software 7.5.3 (or later), this control panel’s capabilities may be included under a 
Monitors & Sound control panel instead, depending on your system type. In this case, you will 
also have a Sound control panel, but with reduced options since they are included under the 
Monitors & Sound control panel.
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this feature is definitely beneficial during many situations, having File Sharing 
“on” while running ObjectDANCER can cause a decrease in performance. 

QuickDraw GX or GXGraphics INIT ?

ObjectDANCER utilizes QuickDraw GX features, a technology developed by 
Apple, offering advanced printing, graphics, typography, and color capabilities that 
are often required by multimedia applications. In the typography area, features 
such as kerning, ligatures, tracking, transfer ink modes, interlettering, animated 
multiple master font support2, and special GX font handling become critical to 
experiencing some of ObjectDANCER’s full potential. In terms of graphics, 
ObjectDANCER offers sophisticated color-modeling and translucency control, and 
extended image quality and rendering performance control, among other image 
features contributed by QuickDraw GX. Given all this, obviously, ObjectDANCER 
relies heavily upon the capabilities of QuickDraw GX technologies. 

There are two different ways to enable QuickDraw GX capabilities on your 
system. They are:

• install the GXGraphics INIT system extension, or 

• install Quickdraw GX. 

The GX Graphics INIT system extension is installed via the ObjectDANCER 
Installer. QuickDraw GX files are included with the System Software 7.5 (or later) 
installation files. 

The GXGraphics INIT, version 1.1.3, is a system extension that adds GX graphics 
capabilities to the your system without changing any printing or installed fonts. 
Since the GXGraphics INIT extension does not change any other resources in your 
system, it can easily be enabled or disabled through your system's Extension's 
Manager, and then restarting your system.

In order to use PostScript Type 1 fonts in your project or to print, you need to 
install QuickDraw GX because the fonts must be converted, or “enabled”, to the 
GX font format. When you install QuickDraw GX, all PostScript Type 1 fonts 
found in your Fonts folder are enabled by the GX Installer. Any fonts installed 
after QuickDraw GX is installed, however, must be enabled using Adobe’s Type 1 
Enabler, version 2.2 (or later).3 

2. Multiple font master is an Adobe font standard. As a QuickDraw GX font, it can support axis 
variation. ObjectDANCER allows you to access and edit GX font features in addition to the 
Adobe multiple font master features.
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QuickTime

QuickTime™ is a software-based architecture developed by Apple that allows a 
developer to easily integrate graphics, sound, text, video, music, and animation 
into a standard multimedia format: a QuickTime movie file. ObjectDANCER takes 
advantage of the QuickTime architecture, allowing a developer to easily create, 
view, edit, synthesize, and compress simple or advanced animations alike.

With System Software 7.5 (or later), the QuickTime™ 2.1 (or later) extension 
should already be installed on your system. Included with the QuickTime 
installation is QuickTime™ Musical Instruments, a system extension that allows 
QuickTime movies to play back a provided set of musical instruments called MIDI 
sounds. ObjectDANCER supports MIDI files, so having the QuickTime Musical 
Instruments system extension on your system is important. A QuickTime™ 
PowerPlug system extension, which improves compression performance on 
PowerPCs using QuickTime 2.1 or later, is also installed with System Software 7.5 
(or later).

CD-ROM Drive 

Most desktop PowerPCs come equipped with an installed CD-ROM drive, so in 
most cases, this recommended requirement is easy. It is not critical that you have a 
CD-ROM, unless you want to import objects from a CD-ROM to use in your 
ObjectDANCER projects.

Monitors 

When creating multimedia productions, it is best to have as large a monitor as 
possible. Although, you can use any sized monitor to work with ObjectDANCER.

Many designers often attach more than one monitor to their systems so they can 
test their multimedia project on one screen, and launch applications to create 
components of the project on another screen. Though this approach works well, is 
efficient, and is certainly a nice enhancement to your system setup, only one 
monitor is required to run ObjectDANCER.

Monitors Control Panel    Set the color level setting within your Monitors control 

3. Refer to QuickDraw GX’s and Adobe’s Type 1 Enabler’s “Read Me” files included with the 
software for more information regarding the compatibility issues associated with Type 1 fonts 
and QuickDraw GX.
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panel4 at the highest color level setting available. If there is ever a time for having 
high quality color on your monitor, designing multimedia is that time.

External Stereo Speakers or Headphones

Since audio plays such a critical and integral role in multimedia productions, and 
specifically, when using the ObjectDANCER authoring tool, investing in quality 
external speakers or headphones to play back your project’s audio files during 
development (and after) seems well worth the money spent. After installing your 
external stereo speakers (or headphones), be sure to adjust the Sound control panel 
to allow “sound out”. Otherwise, even though you have your speakers may be 
physically connected, sound will continue to be outputted through the internal 
computer speakers.

Having external stereo speakers or headphones is a recommendation, not a 
requirement. If you do not have either of these, you can still run ObjectDANCER 
without them.

Installation

Install the PaceWorks’ ObjectDANCER application by double-clicking on the 
ObjectDANCER Installer icon. Proceed with the installation by following the 
prompts provided. After you have been prompted that the installation was 
successful, restart your computer.

Note that QuickTime must also be installed on your PowerPC in order to run 
ObjectDANCER. Since QuickTime is usually installed on PowerPCs during the 
System Software installation, it is probably safe to assume that QuickTime is 
already present on your system. If you find that QuickTime is in fact not installed, 
however, you can install it using the QuickTime Installation files provided on the 
ObjectDANCER CD-ROM.

4. With System Software 7.5.3 (or later), this control panel’s capabilities may also be included 
under a Monitors & Sound control panel, depending on your system type. 
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Opening Scenes

To launch ObjectDANCER, double-click on the application icon. The menu bar in 
the upper left corner of your screen displays the ObjectDANCER’s available menus. 

Throughout the rest of this section, you can follow along in the hands-on demo to 
create your first ObjectDANCER animation. Though this first animation that you 
will create is very simple and basic, the described steps form a foundation to all 
other ObjectDANCER maneuvers that you will encounter in creating more complex 
animations. Therefore, being able to create this basic animation is very important 
before going any further with ObjectDANCER.

After the demo, we will back up and give you more detail on ObjectDANCER’s 
project windows and how you actually created your animation.

Your First Animation in 6 Easy Steps

Create New Project and Select Composition Size    Open a new 
project by selecting the New... command from the File Menu (after 

launching the ObjectDANCER application). When the “Composition Size” dialog 
box is displayed, click on “320 x 240”, and then “OK”.

An empty Compo and Synchro Window is displayed on the top and bottom of 
your screen, respectively. 

1
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Drag and Drop Object    Drag and drop an object, such as a PICT 
graphic, into the Compo Window white area.

When you import an object into the Compo Window, the same object is reflected 
in the Synchro Window, as well (and vice versa). These windows are mirrors of 
each other, essentially, each allowing you to manipulate the objects in different 
ways.

Adjust Time    Drag the current time white highlighted area to the right 
along the gray timeline ruler (keep within the range of the yellow 

project output bar). 

2

Drag graphic object 
to Compo Window 
white area.

3

red current time (RCT) line

current
time
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Move Object    Drag the moon object to the right. A line from the 
original location to the new location shows the object’s path. 

Make Movie    Select the QT Movie command from the Output Menu 
(or click on the QT Movie smart icon at the top of the Synchro 

Window). A “Making Movie” progress screen is displayed, and then a small movie 
window is displayed.

4

5

scrub back/forward - to 
manually scrub movie backward 
or forward.

running indicator - keeps 

play button - click 

track of playing progress

to play movie
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Play Movie    Click on the play button in the movie window, and 
your movie is played. The running indicator on the bottom scroll bar 

moves to the right while the movie plays.

And there you have it! You have created your first ObjectDANCER animation. 
Granted, this animation may not be the most exciting animation of all time. Have 
patience—we We’ll get there. The point is that these simple steps form the 
foundation of all future animation maneuvers that you will create within 
ObjectDANCER: open new project, import object, move current time, move or 
change object, move current time, move or change object, move current time, 
move or change object, and so on.

6
progressive screens...
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ObjectDANCER Basics

The main premise behind ObjectDANCER is timing. Everything you do in 
ObjectDANCER revolves around timing. You will be specifying over and over 
exactly when you want something to happen, change, move, etc. within your 
animation. It is critical to understand the true importance of timing. With this 
understanding clear in your thoughts, you will be able to learn ObjectDANCER with 
ease. 

Now let’s talk about timing a little more specifically, in terms of ObjectDANCER’s 
representations of time within a project: current time and the red current time line. 

Current Time and the Red Current Time Line

The red vertical line in both the Compo and Synchro Windows is known as the red 
current time line, or the RCT line. The positioning of this line along the gray 
timeline ruler represents what your project looks like at the specific current time 
represented by the red type against the white highlighted bar.

The positioning of the objects within the Compo Window at any specific current 
time is what your animation looks like at that specific moment. The RCT line is 

RCT line

current time gray timeline ruler 
block
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simply an extension of the current time, which stretches across the many different 
object lifespans in the Synchro Window. 

When you have created a project with many objects moving and changing at 
different times, by dragging the current time block or RCT line along the gray 
timeline ruler, you can see a wireframe preview of your animation in the Compo 
Window at those specific times—those specific current times. In the early stages of 
your animation, this wireframe preview may not amount to much. As your project 
gets more and more complicated, however, this wireframe preview at any point 
during the creation of you animation is very useful. 

Each and every time you want to make an animated change to an object (e.g., a 
change to location, style, color, size, skew or other object attribute(s)), you must 
first move the current time block or RCT line to a new current time—the time at 
which you would like the change to occur. In turn, each of these changes that are 
made acquires an associated “current time” for exactly when that change is to take 
place. These times (of the changes) are tracked as keyframes in the Synchro 
Window (discussed in more detail later).

Compo and Synchro Windows

The Compo Window is essentially your visual drawing pad for creating movies. 
By collecting multiple objects of different types, sizes, and shapes, and then 
manipulating them in different patterns and schemes over time, you can create 
animations quickly and easily. In ObjectDANCER, an object is any graphic, text, 
movie, or audio file of a supported format1 that is brought together in the project 
windows to be used in the creation of your animation. 

Figure 2-1 shows a Compo Window with a graphic and text object already placed 
inside the Compo build window.

1. Refer to the supported file format list on page 3.
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Figure 2-1 Compo Window: An Animated Visual Drawing Pad

All projects have both a Compo Window and a Synchro Window, the former for 
graphically designing your project, and the latter for precise manipulations of the 
components that make up your project over time. The Synchro Window is 
illustrated in Figure 2-2. 

Figure 2-2 Synchro Window: Tracking Objects and Object Lifespans

As you may have noticed, many of the elements of the Compo Window are also 
elements of the Synchro Window. This is because the Compo and Synchro 
Windows are essentially mirrors of each other, yet each window displays and 
manipulates objects in different ways. The Synchro Window functions as a tracker 
of all incorporated changes in the Compo Window, among other things. In turn, all 
changes made in the Synchro Window are reflected in the Compo Window. Just as 
objects are dragged and dropped into the Compo Window, objects can be dragged 
and dropped into the Synchro Window. And, just as you can make changes to an 
object’s movements and attributes in the Compo Window, you can also make 
changes to an object’s movements and attributes in the Synchro Window. Sound 
objects, however, are only represented in the Synchro Window.

objects- may be PICTs,
QuickTime movies, text, or

QuickDraw GX files.

build window - this white area 
is for visually composing and 
manipulating objects as you 
would like to see them.

gray timeline ruler - a mea-
sure of adjustable time incre-
ments for tracking within a 
project.

current time block- contains the
time of the RCT line’s location,

and as portrayed by the objects
(and their positionings) in the

Compo build window at that
specific time.

yellow project output bar - 
adjustable bar defines the area 
of the project to be “outputted” 
when showing a preview or 
making a movie.

RCT line

object labels - representa-
tions of objects within

Compo Window. Sound
objects are always placed

under the bolded line.

object lifespans - represents 
the time of an object’s life from 
start to finish within a project.

RCT line gray timeline rulercurrent time blockyellow project output bar
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All objects in the Compo Window are represented in the Synchro Window by 
object labels instead of their graphical images. Every object label within the 
Synchro Window also has an associated object lifespan, which shows the time of 
an object’s life from start to finish within a project. The current time block, the 
RCT line, the gray timeline ruler, and the yellow project output bar are all 
duplicated elements in both the Compo and Synchro Window, because these 
components affect the actual trackable time of changes that take place in a project. 
The RCT line along the gray timeline ruler links all the pieces of your animation 
together over time, allowing you to see what your animation looks like at any 
specific time. By moving the RCT line slowly along the gray timeline ruler, you 
can view how your objects are moving, or dancing, in the Compo Window (in a 
wireframe mode). 

Menus

ObjectDANCER has been designed using a very familiar menu-driven interface. 
Upon first opening the application, you are presented with a menu bar of six pull-
down menus: File, Edit, Arrange, Type, Output, and Windows. Figure 2-3 
illustrates the six menus and each menus first level commands. 

Figure 2-3 Main Menus

File Menu    The File Menu contains file commands for creating, opening, closing, 
saving and printing projects, and for importing files from other applications into 
the ObjectDANCER workspace. Many of these commands will be fairly obvious to 
an experienced computer user. 

Edit Menu    The Edit Menu contains commands for undoing and redoing 
ObjectDANCER commands, and for handling clipboard operations such as cutting, 
copying, and pasting. This menu also has commands for selecting objects while 
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composing your project, renaming objects, editing your project’s background 
color, or setting preferences.

Arrange Menu    The Arrange Menu contains commands used for manipulating 
the arrangement and alignment of objects within the Compo Window and Synchro 
Window. 

Type Menu    The Type Menu contains commands for modifying various text 
attributes such as font, font size, text justification, and text style. 

Output Menu    The Output Menu contains commands for compiling your final 
project into a finished movie in different movie formats. In addition, an important 
command on this menu is the Show Preview command which allows you to 
“demo” your movie at interim times during its creation. The preview shown or 
movie created is dependent upon the duration of the yellow project output bar.

Windows Menu    The Windows Menu contains commands for displaying 
accessory tool palettes and windows for precisely manipulating the object 
attributes within a project(s) that you have open. This menu also has commands 
for bringing open projects’ Compo or Synchro Windows to the forefront of your 
screen, which becomes especially useful when you have multiple projects open 
simultaneously and the windows are stacked on top of each other.

Choosing Preferences

Like many applications, ObjectDANCER has a Preferences command where the 
user can establish preferences for how they would like the application to work 
within their environment. Since the preference settings often affect all phases of 
your project work, we are discussing this command early on. Also note that 
changes to preferences settings are maintained as part of the application’s settings, 
so all open projects are affected by a changed preference setting.

The Preferences command can be invoked from the Edit Menu, and offers the user 
three different areas to customly configure: Input, General, and Output.

Input Preferences

The Input Preferences dialogue box allows you to set up default settings that are 
applied when “inputting” objects into your project. By selecting the Input icon 
from the Preferences dialog box, a window similar to Figure 2-4 is displayed.
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Figure 2-4 Input Preferences 

Most of these settings are simply defaults, so if you wanted to modify an object’s 
attribute in these default areas after inputting an object in your project, you could 
do so.

Default font    This setting defines the default font family for the next imported 
text object (dragged and dropped, or copy and pasted), and all following text 
objects until the default is changed. Any text object’s font can be changed 
manually by selecting a different installed font for a selected text object via the 
Text Menu. A text object’s font can also be changed via the object’s attributes list 
in an expanded Synchro Window, or in the Text Attributes palette in the Hub.

Default font size    This setting defines the default font size for the next imported 
text object (dragged and dropped, or copy and pasted), and all following text 
objects until this default is changed. Any text object’s font size can be changed 
manually by selecting a different font size for a selected text object via the Text 
Menu. A text object’s font size can also be changed via the object’s attributes list 
in an expanded Synchro Window, or in the Text Attributes palette in the Hub.

Default text area    This setting defines the default text area for the next imported 
text object (dragged and dropped, or copied and pasted), and all following text 
objects until this default is changed. Any text object’s text area can be changed 
manually by inputting a different text area for a selected text object within the 
object’s attributes list in an expanded Synchro Window, or in the Text Attributes 
palette in the Hub.

Default object lifespan    This setting defines a default object lifespan duration 
from start to finish within a project. This default applies to the next imported 
object, and all following, until this default is changed. Any object’s lifespan can be 
changed manually by dragging on either end of a particular object’s lifespan bar in 
the Synchro Window, or in the Timing Info palette in the Hub. 
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Embed import file    By selecting this option, the next imported object will be 
embedded (as opposed to linked) within the project, and all following imported 
objects until this default is changed. This setting applies not only to objects 
imported via the Import command, but also any objects that are dragged and 
dropped, or copied and pasted into the project windows. 

The effect of this preference option is not adjustable later through editing tools. 
After an object has been embedded, it cannot be linked later, and vice-versa. For 
more details on embedding or linking objects, refer to “Embedded or Linked 
Library Entries” beginning on page 48.

General Preferences

The General Preferences dialogue box allows you to specify overall project-
affecting settings. By selecting the General icon from the Preferences dialog box, a 
window similar to Figure 2-5 is displayed.

Figure 2-5 General Preferences 

Undo level     This special feature allows you to establish an “undo” buffer that 
stores a fixed number of changes, until reaching the specified value. For example, 
if the Undo level is set to 24, the 24 most recent changes at any time during a 
project’s editing process are saved. If you realize that you made a mistake within 
the last 24 commands or actions, you can undo (zU) until you get to the location 
where you made the error and then fix the error.

Note

Even though the value that you enter in the Undo level field is 
unlimited, we recommend that you keep this value reasonable (i.e., less 
than 30) since it represents a buffer size—the larger your buffer is, the 
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more memory your buffer consumes, and the less memory is available 
for ObjectDANCER and other applications.

Output Preferences

The Output Preferences window is used for modifying settings related to the 
output of your project. By selecting the Output icon from the Preferences dialog 
box, a window similar to Figure 2-6 is displayed.

Figure 2-6 Output Preferences

Output size    This setting allows you to set a QuickTime window size that may be 
different than the setting established in the General settings, or the same if you 
check the “Same as project” toggle.

Output antialiasing    The setting options for output antialiasing are None, Low, 
and High which defines the antialiasing rendering quality desired, or specifically, 
the smoothness of edges between adjacent objects or backgrounds. 

Antialiasing is a technique that smooths the jagged edges around objects drawn in 
your animation so that they blend well with adjacent images or the background. 
Since antialiasing requires a complete readjustment of pixels, antialiased images 
usually take longer to render. Therefore, with this Preferences option, you may 
want to select None or Low antialiasing resolution while you are rendering your 
project, and then change the setting to High when you are close to completion of 
your project. Figure 2-7 illustrates antialiasing.
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Figure 2-7 Antialiasing

Designing Your Workspace

ObjectDANCER allows you to design your workspace on your screen in the way 
that best fits your work methods. Some people work with many windows or many 
projects open simultaneously; others want as few windows open as possible, 
feeling too cluttered when too many windows are open. 

With ObjectDANCER, you have a lot of flexibility in this area because of the way 
the window positioning preferences were designed. The positioning of the Compo 
and Synchro Window are specific to each project. You can have multiple projects 
open with each project’s Compo and Synchro Windows specifically positioned, 
and upon opening and closing the projects, the window positionings are saved. The 
positioning preferences of the Compo and Synchro Windows are saved as part of 
each specific project file.

The positioning of the Hub, and any of the tool palettes, such as the Toolbox 
Palette, the Text Attributes Palette, the Object Attributes Palette, or the Timing Info 
Palette are all specific to the application (instead of specific projects). Because of 
this, you will never have more than one set of tool palettes on your screen at any 
given time, even though you may have more than one set of project windows open 
(i.e., Compo and Synchro windows). The positioning of these tool palettes are also 
saved upon closing the application. These positioning preferences are saved within 
the Preferences file, though, not the specific project files. 

As you become more and more familiar with ObjectDANCER, and begin 
composing multiple projects simultaneously, the positioning of windows will have 
greater and greater importance as the need for an organized desktop becomes more 
and more critical. At this early stage, open, close, and move the project windows 
wherever you want on your desktop; the need for heavy organization is probably 
not yet prevalent. 

  
NoneHigh
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All windows, except for the Compo Window, can be closed without quitting a 
project; if you close the Compo Window, you will be prompted to save your 
project before closing. If you close a window that you later decide that you would 
like to reopen, use the commands on the Windows Menu to reopen a specific 
window. This menu’s commands allow you to open, or bring to the forefront (of 
stacked windows) both the project windows and any of tool palettes.

Saving Commands

These saving commands are included at this early stage simply to stress the 
importance of “saving early and saving often”, a rule to follow not only in 
multimedia creation, but in all work efforts on the computer. Most of these saving 
commands (from the File Menu) are typical and common. as used in other 
applications. Unique to ObjectDANCER, however, is the Save Compo as GX..., 
Save Compo as PICT..., Save Compo as GIF... commands. Following are the 
save commands described in more detail:.

Save... (zS)    This command enables you to replace any previously saved version 
with the same name, but with a more current version. Since this command only 
saves your work, and does not close the project, you can continue to work within 
the project. If you are saving the document for the first time, the Save As... 
dialogue box will open instead.

Save As...    Allows you to save an untitled project that you have not previously 
saved, or a copy of a project in a different folder or with a different filename. Type 
a filename for the document in the highlighted Save File As: field, ensure that the 
correct folder is selected, and then click on Save.

Save A Copy As    Allows you to make a saved duplicate copy of a specific 
project under a different filename, or a duplicate copy with the same filename but 
within a different folder.

Revert    Reverts to the last saved version of the project that you are working on. 
You will be prompted to confirm this command, however, because unsaved 
changes will otherwise be lost.

Save Compo as GX...    Saves the Compo Window at the current time as a GX file 
that could later be imported into a ObjectDANCER project as a GX object. Bitmap 
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images can be embedded into a saved GX file. GX files can also be edited by other 
applications that support GX files. 

Save Compo as PICT...    Saves Compo Window as a PICT file.

Save Compo as GIF...    Saves Compo Window as a GIF file.

Previewing

While creating your animations, you may get to know the Show Preview 
command well, since it allows you to play a wireframe preview, illustrating timing 
and movement of your objects before compiling a full-blown movie. By using this 
command regularly, you can quickly and easily see how certain edits work or do 
not work during your creation phase. To show a preview of your project, there a 
few different ways to invoke this command, as follows:

• Select the Show Preview command, located on the Output Menu. 

• Click on one of the Show Preview smart icons located on both the 
Compo or Synchro Windows. 

• The keystroke command is z [enter] (the numeric keypad)

• Drag the RCT line (or current time) slowly from left to right along the 
timeline ruler, and a wireframe preview is displayed at the pace of your drag.
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Pre-Production

Main Project Windows

In the previous chapters, we briefly discussed the Compo and Synchro Windows, 
giving you an initial feel for the project windows and tools that you will use to 
design your animations. In this chapter we will discuss these windows in 
significantly more detail, so you can get up and running with ObjectDANCER as 
quickly as possible. 

Recapping

Let’s recap on a few points about the project windows. 

• Graphics and text objects can be dragged-and-dropped (imported, or cut and 
pasted) into the Compo or Synchro Windows. 

• ObjectDANCER supported file types are numerous, yet specific. Refer to 
“Extensive File Format Support” beginning on page 2 for a complete list.

• Changes in any object’s position, size, shape, color, rotation or other object 
dances over time are known as dances.

• The red current time line along the gray timeline ruler is what links all the 
pieces of your animation together over time, allowing you to see what your 
animation will look like at any specific time—at any specific “current time”.
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• By slowly dragging the red current time line or the current time block along 
the gray timeline ruler, you can view how your objects are moving, or 
dancing, in the Compo Window (in a wireframe mode).

• The yellow project output bar is an adjustable bar that defines the area of the 
project to be “output” when showing a preview or making a movie.

• All changes to objects reflected in the Compo Window, are also reflected, and 
changeable, in the Synchro Window. 

• Object labels and associated object lifespans are automatically created in the 
Synchro Window for every object dragged into the Compo Window (or 
Synchro Window). Sound objects are also represented in the Synchro Window.

Just as the Compo Window is a drawing pad for your animations, the Synchro 
Window is a calculating database, listing the many objects of your project with 
precise dimensions and information about the changes and synchronization 
between these objects in an animation. The Compo and Synchro Windows are 
essentially mirrors of each other, each having different ways of displaying and 
manipulating the project’s objects. The listed objects within the Synchro Window 
are always in order of their stacked position within the Compo Window, with the 
first listed object being the front-most object, and the last listed object being at the 
bottom of the stacked objects.

Detailed Project Windows

Figure 3-1 and Figure 3-2 take a closer look at the Compo and Synchro Windows. 
Note that the duplicated components within the windows are identical in function, 
and at any given time, the adjustable ones, such as the current time block, the red 
current time (RCT) line, or the yellow project output bar, have identical 
positionings along the gray timeline ruler within each respective window. 
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Figure 3-1 Compo Window Snapshot

Figure 3-2 Synchro Window Snapshot
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Project Window Components

The following sections describe the different components of the Compo and 
Synchro Windows in detail. When a component is duplicated in both windows, the 
function is identical between the two windows. 

current time block    Indicated by a red value within a white highlighted area 
along the gray timeline ruler, this value indicates the current time of the animation 
at the specific time and location of the red current time line. The Compo Window 
illustrates the project at the time indicated in this value. You can change the current 
time, and thus the red current time line, by simply dragging the white highlight to 
the left or right as desired.

gray timeline ruler    This ruler is a guide for anything that relates to positioning 
in time in your project. Functionally, this ruler holds the adjustable display units as 
a guide for time-related components, such as the current time, the cursor position, 
the red current time line, the yellow project output bar, object lifespans, etc.

cursor position    Indicated by a thin black line along the gray timeline ruler, this 
line moves synchronously with the horizontal movements of the cursor (i.e., the 
movement of your mouse) within the Synchro Window.

red current time (RCT) line     This red vertical line is one of the most integral 
components of both the Compo and Synchro Windows. Simply put, the 
positioning of the red current time line along the gray timeline ruler represents 
what your project looks like at that specific current time. By moving the RCT line 
along the gray timeline ruler, you can view dancing objects within the project in a 
wireframe mode.

You can manipulate the RCT line in the following different ways: 

• Drag the white current time block along the gray timeline ruler. 

• Drag the RCT line along the gray timeline ruler. 

• Click your cursor along the gray timeline ruler, and the RCT line snaps to 
where you click. 

• Click on an existing purple timing marker along the gray timeline ruler, and 
the RCT line snaps to that same location.

• Click on the current time snap buttons to snap the RCT line in small 
increments to the left or right.
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• Click on the first/last frame buttons to snap the RCT line to the beginning or 
the end of the project.

One of the main functions of the RCT line is to enable changes, movements, 
alterations, or dances of the project’s objects over time. By dragging the RCT line 
along the gray timeline ruler first (or dragging the current time block), and then 
changing an object’s attribute or position in either the Compo or Synchro Window, 
object dances are created within your project. These dances are represented as 
keyframes within the Synchro Window. (Refer to page 39 for more details on 
keyframes.)

By dragging the RCT line slowly along the gray timeline ruler, the Compo 
Window displays a wireframe preview of your project. In the early stages of 
developing your animation, this wireframe preview may not amount to much. As 
your project gets more and more complicated, however, you will be able to see the 
wireframe movements of the objects as they would appear in your animation. If 
you find it difficult to drag the RCT line slow enough to catch all the different 
movements, use the current time snap buttons to maneuver the RCT line 
incrementally and with more control. (Refer to page 17 for more details on the red 
current time line.)

yellow project output bar    The adjustable yellow project output bar defines the 
range of the project to be played back when showing a preview or making a movie. 
Any object dances that are outside the range of the yellow project output bar will 
not be seen in the preview or movie. 

• To adjust the duration (length) of the yellow project output bar, drag on the 
purple IN/OUT adjustment handles to the desired duration. As you drag on the 
left or right end, the cursor changes to  or , respectively.

• To adjust the location of the yellow project output bar (which may be different 
than the beginning of the gray timeline ruler), drag on the middle of the bar; 
the cursor will change to  as you drag the bar to a new location along the 
gray timeline ruler.

IN/OUT adjustment handles    These purple handles at the ends of the yellow bar 
allow you to adjust the duration (length) of the project output bar. By dragging on 
either handle, you can expand or shorten the range of the bar. The cursor changes 
to when dragging the IN handle (left-most handle); the cursor changes 
to when dragging the OUT handle (right-most handle). Also see timeline rail.
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timeline rail    Another quick way to adjust the length of the yellow project output 
bar is to click on the dark gray timeline rail outside the range of the yellow line; 
the yellow area/bar will quickly extend to where you clicked along the gray 
timeline rail.

current time snap buttons    By clicking on these buttons, you can 
move the RCT line incrementally to the left or right, depending on the arrow 
direction of the button that you click on.

first/last frame buttons    By clicking on these buttons, you can move 
the RCT line to the beginning or end of the project, depending on the arrow 
direction of the button that you click on.

display mode units    These red values along the gray timeline ruler in the Compo 
and Synchro Windows indicate different frames in your project, and are displayed 
in a unit notation as specified by the FPS timeline units and set display mode 
option settings. These settings can be modified through their respective smart icons 
within the Synchro Window (i.e., ).

timing marker button    Through this tool, you can mark significant 
timing points that you may want to remember in your project, like when you want 
to align specific audio inflections with particular dances in the project. By clicking 
on the timing marker button, a purple marker appears in the gray bar under the 
gray timeline ruler aligned with the RCT line’s location. For every place that you 
create a purple timing marker in the Compo Window, a matching marker in 
location and numbering also appears in the Synchro Window (or vice-versa).

You can manipulate the purple timing markers, as follows:

• To make a purple timing marker, drag the RCT line along the gray timeline 
ruler to where you want to place a new marker, and then click on the timing 
marker button. 

• To move a purple timing marker to another location, drag the marker along 
the gray bar to a new location. Since the markers are automatically numbered, 
if you move the first marker to the end of a row of markers, for example, all 
markers will be renumbered to remain sequential.

• To add a brief annotation to a purple timing marker, double-click on a 
positioned marker. When the highlighted input area appears adjacent to the 
purple timing marker, type in a brief annotation. To validate (i.e., unhighlight) 
the annotation entry, click anywhere in the window.
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• To quickly jump the RCT line to a purple timing marker location, click on any 
positioned marker, or hit the number corresponding to the marker on the 
numeric pad, and the RCT line will snap in alignment with the marker. 

For example, suppose you have markers: 1, 2, 3, 4,....52, 53, 54..... Normally, 
to skip the current time to a marker, you type in a single digit marker number 
(i.e., 1 - 9) in the numeric keypad, and the current time skips to that marker. If 
you have a double digit marker number to skip to, you need to move the 
current time to a a close by marker first. So if the current time is at marker 53, 
and you type in 6 through the numeric keypad, the current time will jump to 
56.

• To select a specific purple timing marker among all of the established 
markers, hold the mouse button down on the gray bar under the gray timeline 
ruler. A list of positioned markers will be displayed by number. Select the 
marker that you want.

• To delete a positioned purple timing marker, drag the marker out of the gray 
bar area and it will disappear. If the RCT line is aligned with the purple 
marker while you are trying to delete it, drag the RCT line out of the way 
before trying to delete the marker.

object labels    These labels are automatically created in the Synchro Window, 
reflecting all objects that have been imported into the project (i.e., by either 
dragging and dropping, copying and pasting, or importing the objects into the 
Compo or Synchro Windows). Graphics and text object labels are always placed in 
the upper half of the Synchro Window; sound objects are in the lower half.

By double-clicking on an object label within the Synchro Window, a “Rename...” 
dialog box appears, allowing you to rename the selected object.

object icons    An icon to the right of each graphic or text object label within the 
Synchro Window is included so you can easily identify which object is which 
when you need to make modifications to an object(s). 

object lifespans    Object lifespan bars are associated with every object label 
within the Synchro Window, indicating the life of an object from start to finish 
within a project. You can maneuver the object lifespan a few different ways, as 
follows:

• To move the whole object lifespan to the left or right (without expanding or 
shortening the lifespan duration), select (click on) an object lifespan bar and 
hold the mouse button down while dragging it to the left or right, as you wish. 
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In doing this, the cursor changes to the open hand while the cursor is over 
the selected bar, and then a fist  when you drag the lifespan to the left or 
right.

• To expand or shorten the object lifespan, select (click on) an object lifespan 
bar, and then hold down the mouse button over one of the lifespan bar’s end 
handles (i.e., IN or OUT handles), drag the bar in or out, as you wish. In 
doing this, the cursor will change to an open pulling hand while the 
cursor is over the selected bar end, and then a pulling fist when you 
drag the length of the lifespan one way or the other.

keyframe tags    Every time an object dance is changed over time within a project, 
a keyframe is created. For every keyframe created, a keyframe tag is placed along 
the object lifespan bar. (Refer to page 39 for more details about keyframes.)

incremental window sizer icons    The Compo Window can be 
enlarged or reduced by clicking on the big and small “mountain” icons to the left 
of the view setting. The increments to enlarge or reduce the window are fixed 
incremental values.

view setting     The view setting percentile shows you the view size of your 
workspace window. By clicking on the “mountain” icons (i.e., incremental 
window sizer icons) adjacent to the view setting, you can enlarge or reduce the 
view of your workspace.

timeline zoom tool    This tool, which is available in both the Compo 
or Synchro Window, allows you to zoom the project’s timeline in or out. 

• To zoom out or increase the time scale ratio, click on the timeline zoom tool. 
Notice the change in the display mode unit values on the gray timeline ruler; 
your viewing ratio increased. 

• To zoom in of decrease the time scale ratio, hold the [option] key down while 
clicking on the timeline zoom tool; the timeline ratio decreases.

This tool is especially useful in the Synchro window when you have many objects 
spanning over a long period of time in the project. By zooming out, the object 
lifespan bars will visibly decrease (even though their lifespan values remain the 
same), allowing you to view a larger scale of time.

window size box     Allows you to adjust your Compo or Synchro 
Window to be as large or small as you want. By dragging the window size box, 
your window will stretch to the size you want. 

/
/
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Hold the [option] key down while dragging your window to keep the Compo build 
window aligned and centered in the Compo Window. This feature is nice when you 
need to make very precise manipulations.

smart icons    Smart icons are short cut buttons used to invoke frequently used 
editing functions. These icons are displayed in the following icon bars: 

Text Decompose - This icon invokes the Text Decompose... command 
from the Arrange Menu (Compo and Synchro Window).

Shuffle Back - This icon invokes the Shuffle Back command from the 
Arrange Menu (Compo Window only).

Shuffle Forward - This icon invokes the Shuffle Forward command 
from the Arrange Menu (Compo Window only).

Show Timing Markers - This icon displays a pop-up menu of all 
positioned purple timing markers. Select the marker that you want, and 
the RCT line snaps to that same location within the Compo and 
Synchro Window (Compo and Synchro Window).

Make QuickTime Movie - This icon invokes the Make QT Movie 
command from the Output Menu (Compo and Synchro Window).

Make Animated GIF - This icon invokes the Make Animated GIF... 
command from the Output Menu (Compo and Synchro Window).

Show Preview - This icon invokes the Show Preview command from 
the Output Menu (Compo and Synchro Window).

Shuffle Back Shuffle Forward

Show Timing Show 

Set Background Color 

Text Decompose

Time Alignment Center RCT Line
FPS Timeline Unit Settings 

Markers
Make QT

Movie
Make Ani-
mated GIF

GIF Output
Options

QT Output
OptionsPreview

Display Mode Unit Settings 
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QuickTime Output Options - This icon invokes the QT 
Compression... command from the Output/Options Menu (Compo and 
Synchro Window).

GIF Output Options - This icon invokes the GIF... command from the 
Output/Options Menu (Compo and Synchro Window).

Set Background Color - This icon invokes the Background Color... 
command from the Edit Menu (Compo Window only).

Time Alignment - This icon invokes the Time Alignment... command 
from the Arrange Menu is invoked. (Synchro Window only.)

Center RCT Line - By clicking on this icon, the gray timeline ruler will 
horizontally snap to the left or right so the RCT line is centered in the 
Synchro Window (Synchro Window only).

FPS Timeline Unit Settings - This icon displays a pop-up menu where 
you can set the FPS (frames per second) timeline units from the 
following options: Frames 5, 8, 10, 12, 15, 24, 25, 29.97, 30, 50, 60. 
This setting also resets the FPS settings in the Compo Window to match 
(Synchro Window only). 

Display Mode Unit Settings - This icon displays a pop-up menu where 
you can set the display mode units from the following options: 
00:00:00:00 mode, 00;00;00;00 mode, Free mode, or Seconds + frames 
mode.This setting also resets the display mode unit settings in the 
Compo Window to match (Synchro Window only).

The Expanded Synchro Window

You can modify objects in the Compo Window, and you can modify objects more 
precisely through the Synchro Window. By clicking on the dancing attributes list 
arrow to the right of any object label, all attributes associated with a particular 
object are displayed, as illustrated in Figure 3-3.
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Figure 3-3 Expanded Synchro Window

Defined, keyframes are points when an object’s attribute value or setting is fixed at 
a different value than that same attribute’s value at an earlier time during an 
object’s lifespan. These changes are known as dances in a project, and are 
represented by keyframe “mushrooms” along an object’s dance bar. In addition, 
for every keyframe added to an object, small slits appear on an object’s lifespan 
bar known as keyframe tags. These tags are guides only and have no manipulative 
function, but are useful when trying to do alignments or synchronization of audio 
later, for example.

Creating Dances/Keyframes

To create a keyframe in the Synchro Window, drag the RCT line along the dance 
bar to a new current time position. By entering a new value in a selected attribute’s 
input box, and then pressing [return], you will change the selected attribute at the 
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specified current time, and create a new keyframe mushroom. If changes were 
previously made in the Compo Window, a keyframe mushroom for every previous 
change will already be present on the dance bar. Remember, changes made to the 
Compo Window are immediately tracked within the Synchro Window, and vice 
versa—changes made in the Synchro Window are reflected immediately in the 
Compo Window.

For more information about object attributes refer to “A Closer Look at Object 
Attributes,” beginning on page 53.

For more information about manipulating key frames in your project, refer to 
“Chapter 5 • Fine Tuning” beginning on page page 75.

Keeping Track of Project Windows 

Since you can open and stack as many open project windows as you want on top 
of each other (assuming you have enough memory), it is not uncommon that a 
project window gets shuffled below other project windows and you cannot quickly 
find it when you need it. Because of this, there are two ways to help keep track of 
your project windows, and bring them to the forefront of your workspace.

• By invoking the Compo Windows or Synchro Windows commands on the 
Windows Menu, a pull-down menu of all open Compo or Synchro Windows, 
respectively, is displayed where you can select an open Compo or Synchro 
Window and bring it to the forefront of your workspace. 

• If you have the Compo Window already in the front (or Synchro Window), 
and want to find its complementary project window, press z [tab] and the 
associated complementary window will be brought to the forefront of your 
workspace.

The Hub and Its Components

The Hub is a very powerful window where you can organize and store different 
types of objects or object dances in “libraries”. The Hub also offers alternative 
editing mechanisms to editing your project from the Compo or Synchro Windows. 

The Hub is composed of a Library window, an three extractable editing palettes: 
an Object Attributes palette, a Text Attributes palette, and a Timing Info palette. 
By selecting the Show Hub command from the Windows Menu, you can either 
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open the Hub window (if not already opened), or bring an already opened Hub 
window to the forefront of your screen. 

Figure 3-4 illustrates the Hub’s components.

Figure 3-4 Hub Library Window and Extractable Editing Palettes

The extractable Hub editing palettes can be removed from the Hub window as a 
separate “palette” on your desktop. Drag a palette icon to your desktop, and the 
palette is extracted from the Hub window. With this mechanism, you can have all 
three palettes and the Library window open simultaneously while editing projects. 

A palette and a window are different in position as well, in that palettes are always 
in the forefront of your screen, and will not be shifted backward even if they are 
overlaying an active project area. A window, on the other hand, is only an active 
window when you are actively working in it; otherwise, it is shifted to the 
background when you are working on an overlaying window. 

You can differentiate a palette from a window by their distinguishing gray header 
bars. A palette header bar looks like this: , and a window header bar 
looks like this: .

A benefit to editing your project windows through the Hub’s editing palettes 
instead of the expanded Synchro Window’s dancing attributes lists is that when 
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these lists are closed, you can view all objects’ lifespans in your project, one right 
after another. You can easily see where one object starts and ends, as compared 
with another object’s starting and ending locations. When creating animations, 
these precise intervals between objects’ starts and ends are critical to the overall 
design of your project. Therefore, with the Hub’s editing palettes, you can modify 
any project objects’ attribute(s), while still having all project objects’ lifespans in 
full view (because they are closed).

The actual editing mechanisms in the Hub’s editing palettes are basically the same 
as the editing mechanisms found in the expanded Synchro Window’s dancing 
attributes lists. Keyframes are added to object dance bars by first changing the 
current time (i.e., dragging the RCT line or current tine block), and then modifying 
specific objects’ attributes. Of course, after editing objects through the Synchro 
Window’s dancing attributes lists, getting used to the Hub’s editing palettes may 
take a little getting used to. Nonetheless, ObjectDANCER offers you the choice to 
work with whichever tools you are most comfortable with.

Object Attributes Palette

The Object Attributes palette offers modifiable fields similar to those 
found in the dancing attributes lists in the Synchro Window. By first 
moving the RCT line (or current time block) in the Compo or 

Synchro Window, and then inputting changed values in any of the palette fields, a 
keyframe is created on the object’s dance bar(s). Functionally, these fields work 
the same as their matching fields in the Synchro Window.

This palette is extractable from the Hub window to become a stand-alone palette 
on your desktop. To extract the palette, drag the Object Attributes icon to your 
desktop; the palette is then displayed separately. 

By selecting the Show Object Attributes command from the Windows Menu, you 
can open the Object Attributes palette in the Hub if not already opened or existing 
as a separate palette on your desktop. 

Text Attributes Palette

The Text Attributes palette offers modifiable fields similar to those 
found in the text objects’ dancing attributes lists in the Synchro 
Window. By first moving the RCT line (or current time block) in the 

Compo or Synchro Window, and then inputting changed values in any of the 
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palette fields, a keyframe is created on the text object’s dance bar(s). This palette’s 
fields will slightly vary between GX-font text objects and non-GX font text 
objects. Functionally however, these fields work the same as the matching fields in 
the Synchro Window.

This palette is extractable from the Hub window to become a stand-alone palette 
on your desktop. To extract the palette, drag the Text Attributes icon to your 
desktop; the palette is then displayed separately. 

By selecting the Show Text Attributes command from the Windows Menu, you 
can open the Text Attributes palette in the Hub if not already opened or existing as 
a separate palette on your desktop. 

Timing Info Palette

The Timing Info palette includes fields that show the cursor position, 
the delta cursor position, the cursor time, and the current time. None 
of these fields are modifiable directly through input; they are 

changed through the movements of the cursor or the current time. The fields below 
the bolded black separator line refer specifically to a selected object: the start/end 
time (of the object’s lifespan) and the total lifespan (the difference between the 
start and end time). 

This palette is extractable from the Hub window to become a stand-alone palette 
on your desktop. To extract the palette, drag the Timing Info icon to your desktop; 
the palette is then displayed separately. 

By selecting the Show Timing Info command from the Windows Menu, you can 
open the Timing Info palette in the Hub if not already opened or existing as a 
separate palette on your desktop. 

Library Window

The Library window has many features and capabilities that are 
unlike features elsewhere in ObjectDANCER. Libraries store and 
categorize chosen objects or dances so you can use them later in 

different projects. For objects that are unchanged since you imported them into the 
project windows, this type of archive may seem unnecessary. For objects that you 
have spent a significant amount of time customly shaping and designing their 
movements and styles, such library archives become quite valuable.
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You can have several libraries opened simultaneously, just as you can have more 
than one project open simultaneously. Since libraries are not project linked, you 
can copy and paste library entries between different libraries or different projects, 
or, you can open or close a library regardless of whether its associated project is 
open or closed. Further, libraries are saved as individual files on your system, so 
you can share libraries between co-workers working on related projects but on a 
different system, for example. 

More features and details about ObjectDANCER’s libraries are covered in the 
following sections.

Library Entry Types

There are three different entry types that make up libraries in the Library window. 
It is important to understand the difference between these library entries because 
the way you use these entries within your project(s) largely depends on the type of 
entry you are using. The library entry types are:

• raw entries 

• DOB (dancing object) entries 

• dance(s)-only entries 

Raw entries are typically unchanged graphics, text, or audio files that you have 
stored somewhere on your system. Raw entries can basically come from anywhere 
in your past work, as long as the format of the entry meets an ObjectDANCER 
supported format. Examples of raw entries could be a graphic created with a 
graphics application, or a Scrapbook entry, or Note Pad entry, or a MIDI sound 
file. The only constraint on raw entries is that they must be a format supported by 
ObjectDANCER (refer to “Extensive File Format Support” beginning on page 2 for 
a complete list). 

Note

For files downloaded from the Internet, use a filter program to ensure 
that the downloaded file(s) is in fact the filetype that you think, and to 
ensure that the file format has not been corrupted or changed during the 
download process. There are a number of freeware and shareware filters 
available on the Internet.
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DOB entries, also known as dancing objects, are objects that dance or change over 
time. Some examples of a DOB entry might be a text object that changes color or 
font, or a graphic object that rotates, or gets larger or smaller, over the course of 
your project. These entries differ from raw entries in that these objects have 
already been modified within a project to move and look exactly as you want. 

A dance(s)-only entry is a specific changed attribute(s) of an object, but without 
the associated object included within the library entry. You can save a single dance 
of an object (e.g., a changed rotation), or many dances grouped as one entry (e.g., 
changed rotation, color, etc.).

Identifying Different Library Entries in the Library Window

On the bottom bar of the Library window, there are some icons to help organize 
and identify different library entries easier. By clicking on the icon, only 
dances-only types of entries are displayed in the Library window. By clicking on 
the icon, only raw or DOB types of entries are displayed. By clicking on the 

icon, all library entries are displayed. 

Creating Library Catalogs

Before you use the Library window for the first time, there are no library entries or 
library catalogs. A library catalog is similar to a file folder, except it is a folder, or 
container, of library entries. Library catalogs are created to organize and “catalog” 
your collection of library entries. You can create a separate library catalog for 
every project, or separate catalogs for different types of object entries, or whatever 
other cataloging strategy that works best for you. 

To create a library catalog, hold down your mouse button on the Library window’s 
pull-down menu and select “New Library...” from among the menu choices. 

Figure 3-5 Creating a New Library Catalog

library 
management
commands 
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A dialog box is displayed for inputting the name of a new library catalog. Notice 
the folder selected in the dialog box—this is where your new catalog will be 
placed on your system. One idea is to create a folder called “Libraries” within 
your ObjectDANCER application folder (with the “New 0 ” option). Then, you 
can place all your library catalogs in one place: in the Libraries folder.

Figure 3-6 Creating a New Library Catalog in a “Libraries” Folder

As mentioned earlier, libraries are not linked to project files, so you can name 
them anything you want, and you can open any previously created library 
whenever you need it, regardless of whether an associated project is open. Also, 
you can open multiple libraries at once.

With your newly created library catalog(s), you can then import or drag objects 
into your open library catalog(s) in an organized fashion. 

Note

If you do not create a catalog beforehand, and drag an object into the 
Library window anyway, ObjectDANCER will assume that you want to 
create a new library first, and will display the new library catalog dialog 
box.

Library Management Commands

The library management commands on the Library window’s pull-down menu are 
defined as follows:

• New Library - Creates a new library catalog.

• Open Library - Opens a previously created library catalog.

• Close Library - Closes a previously opened library catalog.
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• Save Library As... - Saves a copy of a selected library catalog under a different 
name, or an exact copy with the same name in a different folder.

• Sort Chronologically - Sorts library entries within a selected library catalog in 
chronological order of when they were added to the library catalog.

• Sort by Name - Sorts the library entries within a selected library catalog in 
alphabetical order.

• Sort by Dimension - Sorts library entries within a selected library catalog by 
size (kilobytes).

• Sort by Kind - Sorts library entries within a selected library catalog by the 
type of entries.

You can have more than one library catalog open simultaneously; the names of all 
open library catalogs are displayed just above the library management commands 
on the pull-down menu. You can also switch back and forth between different 
library catalogs through this menu. When you invoke a the sort command, the sort 
takes place for opened library catalog displayed in the Library window.

Adding Library Entries to a Library

Although adding library entries is as simple as dragging and dropping (or copying 
and pasting) items into an open library catalog, there a few points worth 
mentioning, given the different types of entries.

Raw entries    Raw entries are added by dragging a file (of a supported filetype—
refer to “Extensive File Format Support” beginning on page 2 for a complete list) 
saved elsewhere on your system into an open library catalog. Scrapbook entries, or 
some text from the Note Pad can also be dragged into an open library catalog. As 
you drag these objects into a library catalog, an entry for each dragged object is 
displayed in the Library window. A thumbnail graphical representations of the 
objects are shown for easy identification of the kind of library entry it is. 

DOB entries    DOB entries are added to an open library catalog by clicking on 
the dancing object’s label in the Synchro Window, and then dragging it into the 
open library catalog. These objects, both in the Synchro Window and the library 
catalog, will have the same name (until you change the name(s), that is, by double-
clicking on their object label). 

Dance(s)-only entries    For specific dances of objects that you would like to 
apply later to other objects within a project, click and highlight an object’s 
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attribute label in an “expanded” Synchro Window, and drag it into an open library 
catalog. To save multiple dances as a single grouped library entry, hold [shift] 
down while selecting desired object attributes within a dancing attributes list (in 
the Synchro Window), and then drag them into an open library catalog in a single 
drag movement. 

Embedded or Linked Library Entries

Library entries can be either embedded or linked in a library catalog. While 
embedding objects within library catalogs keeps all the objects’ sources neatly 
together, it also increases a catalog’s size substantially, and in turn, increases a 
project’s size as well as the objects are dragged into a project from a library 
catalog. By linking objects instead, a library catalog’s size is significantly reduced 
because only the pathnames of linked objects are saved. Further, the memory 
weight of saving multiple copies of a particular embedded library entry in multiple 
library catalogs is not incurred, thus keeping memory usage to a minimum. Linked 
and embedded files are clearly identified in a library catalog: linked files are in 
italics; embedded files are bolded.

Whether files are embedded or linked is partly based on the pre-set “Embed import 
file” Input Preferences setting. When this setting is toggled on, all imported files 
are embedded, by default. If this preference is not set, however, these general rules 
apply: files dragged and dropped into a library catalog (i.e., raw entries) are linked; 
files copied and pasted into a library catalog (i.e., raw entries) are embedded; a file 
linked or embedded in the library catalog, and then dragged into a project, is also 
linked or embedded, respectively, within the project. 

If you move file(s) from one machine to another, or from one folder to another, the 
linked files must also be moved in the same hierarchical folder positioning, or the 
links are lost. If your lose object links, you have to reset the links upon re-opening 
the moved files because a project always searches for all linked files/objects upon 
being opened. Linked objects that are later deleted from a catalog using the 
[delete] key, are deleted permanently from a catalog, but not from your system. An 
object(s) deleted within your project file should still be available wherever you 
filed the object file within your system files. 

Importing Library Entries into your Project

Import library entries into your project by clicking on an entry(s) within an open 
library, and then: 
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• For raw or DOB entries, drag and drop (or copy and paste) the object(s) into 
the Compo or Synchro Window. 

• For dance(s)-only entries, drag the entry on top of an object label within the 
Synchro Window. 

Note

You cannot apply GX typography attributes (which would be a dance(s)-
only entry) to non-GX text objects. If you attempt to drag a GX 
typography attributes library entry over a non-GX text object within the 
Synchro Window, the destination object is not be highlighted, thus 
disallowing you to apply the GX attributes. The reason for this is that 
GX typography attributes are font family-specific, so it is not possible 
to mix these types of attributes with non-GX fonts.

Once you have imported an object from a library catalog into a project window, 
you can continue manipulate the object’s dances within the project, but without 
modifying the dances of that same object still resident in the library catalog. You 
can later update a library entry with changes you made in a project window by 
dragging the changed object into the library catalog, which creates a new library 
entry. Delete the old entry that is now outdated, unless you want to keep both 
versions. If keeping both versions, rename them appropriately so you can easily 
distinguish them.

Renaming Library Entries

To rename a library entry (or object within the Synchro Window, for that matter), 
double-click on the object label to be renamed. A Rename... dialog box is 
displayed, where you can input a new name.

Deleting Library Entries

You can delete an entry three different ways. After first selecting the entry(s) to be 
deleted: 

• select the Cut command (from the Edit Menu)

• press zX 

• press the [delete] key
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To select multiple entries in a continuous range, hold [shift] down while clicking 
on the top and bottom entry within the range. To select multiple entries, but which 
are not listed in a continuous range, hold the z key while selecting objects. 

Before the selected object(s) is deleted, a dialog box stating “Confirm to clear 
selected items from library? This operation has no Undo.” appears. Press “Clear” 
to confirm, or “Cancel” to cancel.

Show Library

By selecting the Show Library command from the Windows Menu, you can either 
open the Hub window with an open library catalog displayed, or the Hub window 
with a pop-up bar to create a new library catalog or open an existing one (among 
other capabilities). If the Library window were previously opened, this command 
brings the window to the forefront of your open windows. 

Toolbox Palette

ObjectDANCER provides you with another very important palette—the Toolbox 
palette. This palette is accessible from the Windows Menu by selecting the Show 
Tools command. With the tools on this palette, you can apply special editing 
functions to different types of objects within your project. Since the tools on this 
palette are used regularly while working within the Compo, Synchro, or Sound 
Windows, this palette can remain open on your screen as you work (as with any 
palette). Figure 3-7 shows the tools available on the Toolbox palette.

Figure 3-7 Toolbox Palette 

Following are descriptions on how to use the tools in the Toolbox palette.

hand tool    The hand tool enables you to drag the viewing area within 
the Compo, Synchro, and Sound Windows. By selecting this tool, your cursor will 

hand tool

text tool

rotate tool

skew tool

eyedropper tool

zoom toggle tool

scale tool

paint bucket tool

color picker box

arrow tool/bezier point tools 
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change to an open hand  when your mouse button is unclicked, or a fist  as 
you drag the viewing area left, right, up or down, as needed. 

arrow tool    The arrow tool, as your primary cursor for selecting and 
editing objects, is typically the selected default tool within the Toolbox palette; all 
other tools are special purpose tools (including the underlying bezier point tools). 
Within the Compo Window, after selecting an object(s) with the arrow tool, you 
can adjust its position by dragging it to a new location, or edit an object’s path by 
first changing the current time, and then dragging the object to a new location. You 
can adjust an object’s scale by dragging on the corner handles. With graphics, the 
skew changes by dragging on an object’s middle handles; with text objects, the 
text area changes by dragging on the object’s middle handles. 

The arrow tool is also used for selecting multiple objects while holding down the 
[shift] key. After selecting objects, you can “gloup”, “ungloup”, cut, delete, or 
copy and paste objects. For more details on additional keystroke commands with 
the arrow tool, refer to Appendix A.

The small arrow adjacent to the arrow tool icon indicates that there are additional 
tools beneath this tool button. See bezier point tools that follow.

bezier point tools    By holding down your mouse button while 
selecting the arrow tool, you are presented with the bezier point tools. These tools 
are used for editing the path between an object’s current position and delta 
position within the Compo Window. Bezier points are also used for editing the 
speed slope/bezier curves within object attributes’ Speed Variation Windows. 

Since the usage of bezier point tools to manipulate bezier points and curves 
warrants a full discussion on bezier curve editing, refer to the “Editing the Curve 
with Bezier Points” section beginning on page 75 for more details about using the 
bezier point tools. Also, refer to “Speed between Keyframes” beginning on 
page 85 about using bezier tools to adjust the speed between keyframes. 

text tool    This tool allows you to create text objects or modify text 
objects’ dances within the Compo Window. By selecting this tool, and then 
selecting a text object, you can edit the content of the text object by highlighting 
portions of the text, cutting or deleting it, copying and pasting it, or typing 
additional text. You can also edit text by just double-clicking on the text object, 
and the cursor will change to text edit mode.

zoom toggle tools    These tools enable you to zoom in or zoom out 
the timeline scale of the Compo, Synchro, or Sound Windows, depending on 
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where you click. These tools work as a toggle (indicated by the small arrow 
adjacent to the tool icon), whereby the opposite tool is accessed by holding down 
your mouse button while selecting the zoom tool icon.

rotate tool    This tool allows you to manually rotate objects by dragging 
on an object’s corner handles. Use the z key while clicking on a corner handle to 
switch from the arrow cursor to the rotation cursor.

skew tool    This tool allows you to manually rotate objects by dragging 
on an object’s side, top, or bottom middle handle. Use the z key to while clicking 
on a middle handle to switch from the arrow cursor to the skew cursor.

scale tool    This tool allows you to manually scale objects to be larger or 
smaller by dragging on an object’s handle. 

eyedropper tool     This tool allows you to drag your eyedropper cursor 
over an existing color anywhere in the Compo Window, which changes the color 
picker box as you drag, real-time, showing the color of the pixel underneath the 
point of the eyedropper cursor. When your eyedropper cursor is over the color that 
you want, click on the paint bucket tool, and then click on a text or GX object. The 
selected text or GX object will take on the new color.

paint bucket tool    This tool works hand in hand with the color indicated 
in the color picker box to apply a chosen color to text or GX objects. 

color picker box    This box holds the real-time color sample as selected 
while dragging the eyedropper tool over colored objects within the Compo 
Window. 

Another way this tool can be used is to click on the color picker box and the color 
picker window is launched where you can mix and select a color of your choice. 
Use the paint bucket tool to apply the selected new color to a text object or GX 
object.

Show Tools

By selecting the Show Tools command from the Windows Menu, you can either 
open the Toolbox palette if not already opened on your desktop. Since the tools on 
this palette are used regularly while working within the Compo, Synchro, or 
Sound Windows, you can leave this palette (as with any palette) open on your 
desktop so it is readily available whenever you need it. 
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A Closer Look at Object Attributes

As you can see by the expanded Synchro Window in Figure 3-3, objects have great 
depth as far as how their attributes can be changed and manipulated throughout 
their lifespan in your project. 

Common Attributes

The many text and graphics object attributes are extensive, thanks to QuickDraw 
GX capabilities. Following are some details about each of the common text and 
graphics attributes (text-only and audio-only attributes follow this section).

visibility    This is a toggle to make a text object visible or invisible at a 
specified time that a visibility keyframe exists. By default, this dance is 

checked and the object is visible. When unchecked, the object becomes invisible. 

position    These x, y coordinate values specify the object’s anchor point 
position within the Compo Window. For points of reference, the 0,0 

position is in the upper left corner of the Compo build window; the bottom right 
corner is equal to the dimensions of the window as designated upon first opening 
your project file (e.g., 320, 240 x, y coordinate would be a 320 x 240 window).

rotation    A degree value is inputted in this field to modify the rotation 
of the text object around its center anchor point. This attribute can also be 

modified by selecting the rotate tool from the Toolbox palette, and manually 
dragging a corner handle of the object in the desired direction.

scale    These x, y coordinate values represent the enlargement of the 
object with respect to its original size. This dance can be modified by 

selecting the scale tool from the Toolbox palette and dragging a corner handle of 
the object to the desired size. Also, new values can be inputted in these fields to 
add a new keyframe and change the scale coordinates.

anchor point     These x, y coordinate values specify the relative position 
of the anchor point compared with the upper left corner of the object. 

New values can be inputted in these fields to add a new keyframe and change the 
anchor point position.

skew    These x, y coordinate values correlate to geometric coordinate 
mappings of the center anchor point for the object that will be distorted, 



54 ObjectDANCER Reference Manual

or skewed, by changing the angle value between the x and y axis. This dance can 
be modified by selecting the skew tool from the Toolbox palette and dragging a 
middle bordering handle of the object to the desired skew. Also, new values can be 
inputted in these fields to add a new keyframe and change the skew coordinates.

opacity    A percentage value can be inputted to change how opaque the 
object is compared with overlaying or underlaying objects. The lower the 

opacity value, the more “see through” the object is; the higher the opacity value, 
the more opaque the object is. 0 means transparent.

Note

The opacity attribute only allows inputs when the Straight Alpha or 
Translucent transfer modes are selected.

transfer ink modes    With transfer ink modes, you can manipulate the 
way, or mode, of transferring the color of text or graphics objects to their 

destination component. The different QuickDraw GX modes specify the 
interaction between the color in the ink object and the existing color or colors of 
the destination. You can make an object opaque or transparent, draw only part of it, 
change its color, or combine its color with the destination image’s color in many 
different ways. 

The following transfer ink modes and examples demonstrate these variations.1 

• Opaque - The ink object color component is copied to the destination 
component. The destination component is ignored. This is the most common 
transfer ink mode, and is the default for QuickDraw GX. 

• Overprint RGB - The ink object color component is added to the destination 
component, but the result is not allowed to exceed the maximum value.

1. Apple Computer, Inc., Inside Macintosh: QuickDraw GX, Addison Wesley, 1994.

ink object Destination Result

ink object Destination Result
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• Translucent - The result is the average of the ink object and destination color 
components, weighted by a ratio specified by the operand component. When 
this transfer mode is selected, the degree of blending can be modified by 
changing the opacity attribute’s percentage. 

• Migrate - The destination color component is moved toward the ink object 
component by the value of the step specified in the operand component. 
Migrate is similar to Translucent, except that the change in destination 
component is an absolute amount, rather than a proportion of the difference 
between it and the ink object component.

• Tinted Glass - The ink object component replaces the destination component 
only if the ink object component has a smaller value (drawing occurs only 
within the area occupied by the cloud).

• Tinted Light - The ink object component replaces the destination component 
only if the ink object component has a larger value (drawing occurs only 
outside of the area occupied by the cloud).

• Highlight - The ink object component and operand component are swapped in 
the destination component. Other component values in the destination 

ink object Destination Result

ink object Destination Result

ink object Destination Result

ink object Destination Result
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component are ignored. In text, it gives the effect of drawing over the letters 
with a highlighting pen. 

• And - The bits of the ink object color and destination color are combined 
using an AND operation. Only bits that are set in both the ink object and 
destination remain set in the result. 

• Or - The bits of the ink object color and destination color are combined using 
an OR operation. Bits that are set in either the ink object or the destination or 
in both are set in the result.

• Xor - The bits of the ink object color and destination color are combined using 
an exclusive-OR (XOR) operation. Bits that are set in the ink object but not 
the destination, and bits that are set in the destination but not the ink object, 
are set in the result. All other bits are cleared in the result. 

• Ramp And - The ink object and destination color components are normalized, 
and the result of (ink object * destination) is the result. 

Ink Object Destination Result

ink object Destination Result

ink object Destination Result

ink object Destination Result

ink object Destination Result
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• Ramp Or - The ink object and destination color components are normalized, 
and the result of (ink object + destination – ink object * destination) is the 
result. 

• Revert - The ink object and destination color components are normalized, and 
the result of (ink object + destination – 2 * ink object * destination) is the 
result. 

• Over - The ink object color is copied to the destination, and the ink object 
transparency controls where the destination color shows through. Where both 
are transparent, no drawing occurs (result equals destination). When this 
transfer mode is selected, the alpha channel is activated, and the degree of 
over blending can be modified by changing the opacity dance’s percentage.

• Straight Alpha - The ink object color is placed over the destination, but the 
resulting destination retains the original destination’s transparency. The effect 
is that opaque parts of the ink object are clipped to cover only opaque parts of 
the destination. 

• Exclude - The destination color remains visible only where the ink object is 
transparent, and the ink object color is copied anywhere the destination is 

ink object Destination Result

Ink Object Destination Result

Ink Object Destination Result

Ink Object Destination Result
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transparent. Where both are transparent, no drawing occurs (result equals 
destination); where both are opaque, the result color is 0 (no intensity). 

• Fade - The ink object is blended with the destination, using the relative alpha 
values as the ratio for the blend. Where both are transparent, the result is the 
average of the ink object and the destination). 

alpha channel    By selecting this toggle, you are essentially selecting 
the Over transfer mode, and activating the alpha channel. By default, 

alpha channel is unchecked and not activated (Straight Alpha mode).

color    Allows you to change the color of a GX object. By clicking on 
the color bar (which might be a black or gray bar if you haven’t changed 

color yet) to the left of the icon, a color picker window is opened where you can 
modify the color of the object. 

Text Object Attributes

Following are some details about each of the text attributes. Many of these 
attributes can be changed through the Type Menu options as well.

color    Allows you to change the color of the text object. By clicking on 
the color bar (which might be a black or gray bar if you haven’t changed 

color yet) to the left of the icon, an color picker window is opened where you can 
modify the color of the text object.

font family    Allows you to access a font family pop-up menu and 
change the font of the text object from among the font families installed 

on your system.

font size    Allows you to change the size of the font within the chosen 
font family.

Ink Object Destination Result

Ink Object Destination Result
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text area    Allows you to modify the text area that has been designated 
for the text object to fit in.When text is entered that does not fit neatly in 

the given text area, the text is wrapped onto the next line.

layout justification    The layout justification percent setting correlates to 
the spread justification positioning of the text within its specified text 

area, whereby a 0 value specifies no justification (i.e., normal), a 100 value 
specifies full justification, and a value in between means that the extra space in the 
text area is proportionally distributed among the text characters within the text 
object.

layout flush    The layout flush setting correlates to the horizontal 
positioning of the text within its specified text area, whereby a 0 value 

specifies left justification, a 100 value specifies right justification, and a value in 
between means the text is proportionally positioned between the left and right 
margins of the text area. For example: 

In a Synchro Window text attributes list, the layout flush is represented by a 
percentage value. In the Hub’s Text Attributes palette, however, layout flush is 
graphically represented with icons illustrating flush settings.

Spacing    This setting adjusts the spacing proportionally among 
characters within a text object.
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Leading    This setting allows you establish a set amount of spacing 
between lines when multiple lines exist in a particular text object (much 

like the “leading” value that you can set in most word processing applications). An 
empty value indicates that the “default” leading will be used.

track    This attribute only applies to text using a GX font. This setting 
allows you to adjust (increase or decrease) the spacing between 

characters; this a value specifies the relative tightness or looseness of spacing 
between characters. Positive track settings result in an increase in the looseness of 
all characters in the text object. Negative track settings result in a increase in the 
tightness of all characters in the text object. The actual amount of spreading or 
compression between characters is controlled by the font, and can vary with point 
size. For example: 

GX typography and Adobe multiple font master attributes    If you 
select a GX or Adobe Multiple Font Master font as the font family of 

your text object, you will typically be offered a number of additional attribute 
settings. These special settings are not described here, and often may only be 
described in the documentation that comes with the GX or Adobe font. 
Manipulating text objects that are in a GX or Adobe Multiple Font Master font is 
very powerful, since there are so many ways to manipulate the text. 

Audio Object Attributes

Following are some details about the audio attributes.

volume    You can adjust the volume level of your audio file during play 
within your project by adding additional keyframes along the volume 

dance bar with values from 1 to 100, whereby 1 is essentially mute, and 100 is the 
loudest.

Dance WITH US

Dance WITH US

Dance WITH US

track > 0 (10%)

track = 0 (0%)

track < 0 (-10%)
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balance    The balance attribute is similar to the balance setting on your 
home stereo; it is the stereo distribution between the left and right 

speakers. (AIFF audios only)



62 ObjectDANCER Reference Manual



63

Chapter 4 l

Basic Choreography

Importing Objects

As alluded to many times already, projects are made up of many object files 
carefully manipulated in precise and intentional patterns. In order to get all the 
different objects into the project windows in the first place, though, you have to 
import them. 

ObjectDANCER allows objects to be imported into the project windows through 
either dragging and dropping, copying and pasting, or using the Import command 
from the File Menu. Since there are a few notable considerations for each of these 
different import methods, these mechanisms have been described in more detail in 
the following sections. Common to all import mechanisms, however, is the type of 
files that can be imported. 

To recap from Chapter 1, the following list summarizes the different 
ObjectDANCER supported file formats:

Image

• GIF (*.GIF files)

• JPEG (*.JPG files)

• PICT

• GX graphics or text
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• rgb.sgi

• ASCII text 

• Adobe PhotoShop

• MacPaint

• QuickTime movies, including sprite, video, or text tracks

Text

• direct input text

• ASCII

ObjectDANCER Projects

Sound

• AIFF

• AIFC (IMA 4:1, MACE 3:1 MACE 6:1, µlaw 2:1)

• WAV (*.WAV files)

• AU (*.AU files)

• DigiDesign Sound Designer II 

• QuickTime sound tracks

MIDI files

• *.MID files

• QuickTime MIDI tracks

Audio CD 

• Drag and drop track from audio CD

Depending on the way you import objects into your project and/or depending on 
the pre-set Input Preferences setting (i.e., “imported file embedded”), you can 
either embed or link objects. While embedding objects within your project keeps 
all the objects neatly together, it also increases your project’s size immensely. By 
linking objects instead, your project’s size will be significantly reduced because 
only the pathname is saved, or linked, to the linked object. Further, if you later 
changed a linked file, your project file is automatically updated with the new 
version of the linked object. If the same object file is linked in multiple places 
within a project, all linked locations are updated simultaneously. If your objects 



Chapter 4 • Basic Choreography 65

are embedded instead, you must re-import any changed object files into your 
project. 

A project can have a combination of linked objects and embedded objects. To 
identify which is linked and which is embedded, you would have to have all your 
projects also in a Hub library. Linked files will always be listed in the Hub library 
in italics; embedded files are always listed in bold type.

If you move a project file(s) from one machine to another, or from one folder to 
another, the linked files must also be moved in the same hierarchical folder 
positioning, or the links will be lost. If your lose your object links, you will have to 
reset the links upon re-opening the moved project file because a project always 
searches for all linked files/objects upon being opened. 

Linked objects that are later deleted from your project using the [delete] key on 
your keyboard, are deleted permanently from your project, but not from your 
system. An object(s) deleted within your project file should still be available 
wherever you have filed the object file within your system files. 

For all of these reasons, it is important to plan which way you want to import your 
project’s objects before getting too far in your design effort. The following 
sections describe the three different import mechanisms in more detail, in addition 
to defining when objects are linked or embedded using the different mechanisms.

Drag and Drop

The first import mechanism is drag and drop. Drag and drop objects can come 
from multiple sources, such as the Scrapbook, or Note Pad (in your  Menu), or 
from files created in other applications. Similarly, you can always drag and drop an 
object from a Hub library into on of your project windows. As long as the object 
being dragged and dropped is of an ObjectDANCER supported format, and the 
application that the object is being dragged from supports drag and drop 
capabilities, the object can be dragged and dropped into the project windows. 

From an open file of a supported filetype, click or highlight the object that you 
want to drag and drop. To select multiple objects from within the same file, hold 
[shift] down while selecting (highlighting) the objects. Then, drag and drop the 
object(s) into a project window.

You can drag and drop a closed file of a supported filetype directly into your 
project windows as well. Highlight the file’s icon on your system, and then drag 
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(and drop) it into the Synchro Window. This method is particularly for graphics or 
audio files, not large text document files. 

If an object is drag and dropped from another application’s open file, then the 
object is always embedded. All other drag and drop objects are embedded or 
linked, depending on the established Input Preferences option.

Once an object(s) has been dragged and dropped into the project windows, the 
object(s) may be adjusted or edited to a desired size, location, position, etc. by 
using ObjectDANCER’s editing tools. 

Copy and Paste

The second import mechanism is to use the Copy and Paste commands from the 
Edit Menu. Such objects can be copied from multiple sources, such as the 
Scrapbook, or Note Pad (in your  Menu), for from files created in other 
applications which support the same filetype formats that ObjectDANCER supports. 
Regardless of where you copy your objects from, the copy and paste mechanism 
remains the same: 

1. Click or highlight the object to be imported. To copy multiple objects from 
within the same file, hold [shift] down while selecting (highlighting) the 
objects. 

2. Select the Copy command (or zC) from the Edit Menu. 

3. Click your mouse in an open project window to make it active (either a 
Compo or Synchro window).

4. Select the Paste command (or zP) from the Edit Menu. 

Copy and paste objects are always embedded into projects instead of linked.

Once an object(s) has been pasted into the project windows, any object may be 
adjusted or edited to a desired size, location, position, etc. by using 
ObjectDANCER’s editing capabilities. If you would like to change the name of any 
imported object, double-click on the object label and a Rename... dialog box will 
appear. 

Import Command

The third and final import mechanism is to use the Import command from the File 
Menu. Upon selecting this command, you are presented with a dialog box similar 
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to Figure 4-1, which includes a scroll box listing files from the folder that you last 
opened. To select a different folder, use the pull-down menu above the file list.

Figure 4-1 Import Command Dialog Box

The icons at the bottom of the window represent the different types of files that 
you can display within the scroll box, and ultimately the types of files that you can 
import into an ObjectDANCER project.

By checking the Show Preview option, you can display thumbnail representations 
of the files that you want to import on the left side of the dialog box. By checking 
the Link to File toggle option, ObjectDANCER allows you to specify that all objects 
imported with the Import command should be linked to your project, until 
otherwise unchecked; if unchecked, the imported object(s) through this dialog box 
will be embedded in the project file instead. 

By clicking on Import All, all files within the specified folder that are 
ObjectDANCER-supported filetypes will be imported into your project. To select 
only one object at a time, highlight a file and then click on the Import button.

Once an object(s) has been imported into a project window, the object(s) may be 
adjusted or edited to a desired size, location, position, etc. by using 
ObjectDANCER’s editing tools. 

Editing Commands

ObjectDANCER uses very familiar object manipulation commands that are 
commonly found in many other applications, so reviewing these commands should 
be fairly straight forward. 
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The Cut (zX), Copy (zC), and Paste (zV) commands can be categorized as 
“clipboard commands”. When you Cut or Copy a selected object(s) within a 
project, the contents are always stored in a clipboard buffer until another 
subsequent command replaces the clipboard buffer’s contents. The Paste 
command works in the opposite way, in that it pastes the clipboard contents into a 
project window.1 The Clear command removes a selected object(s) without saving 
a copy to the clipboard. Using the Clear command is the same as selecting an 
object(s) and pressing the [delete] key on your keyboard.

If you are editing text objects as a whole, then the text objects are manipulated just 
like a graphic object: they are cut, copied, pasted, or cleared as a singular object 
(even if your text object is multiple letters, words, or lines). If you want to edit the 
actual content of the text object, you must first click on the text tool in the Toolbox 
Palette, and then click on the text object to edit the content. 

You can cut, copy, paste, or clear objects or object attributes between windows, 
projects, or even Hub libraries, and, if you invoke any of these commands by 
mistake, you can easily undo the command through the Undo command. To redo a 
command that you “undo”, select the Redo command. In fact, you can undo (or 
redo) 10 or 20 or more changes, if needed, thanks to a special setting offered in the 
General Preferences dialog box (from the Edit Menu). The Undo level setting 
allows you to establish a buffer size of a certain amount of changes that you can 
undo (and then redo). Refer to the “General Preferences” beginning on page 23 for 
more details on the Undo level setting.

Note

Even though the value you enter in the Undo level is unlimited, it is 
recommended that you keep the number reasonable since it represents a 
buffer size. The larger your buffer size is, the more likely your chances 
are of crashing your system because of running out of memory.

Some commands—such as opening or saving a file or selecting objects—are 
irreversible, however. When an action cannot be undone, you can revert to the last 
saved version of the file by using the Revert... command on the File Menu.

1. Refer to the “Paste Special” section beginning on page 80 to learn about additional pasting 
features.
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Controlling Object Stacking Order

When you drag and drop objects into the Compo Window, each new object is 
placed in front of all other objects that may already be in the Compo Window. If 
the new object is opaque, it covers up objects in back of it. By using the Send to 
Back, Bring to Front, Shuffle Back, and Shuffle Forward commands from the 
Arrange Menu, you can change the objects’ “stacking order” within your Compo 
Window. This stacking order ultimately affects the way items are displayed and 
printed relative to one another. The stacking order of graphics and text objects is 
also illustrated in the Synchro Window, whereby the first listed object is the front-
most object in the Compo Window, and the final object listed is the back-most 
object in the Compo Window.

The Send to Back (zB) command brings a selected object(s) at the back (or 
bottom) of a stack of objects to the front (or top) of the stack; the Bring to Front 
(zF) command sends a selected object(s) at the front (or top) of a stack of objects 
to the back (or bottom) of the stack. The Shuffle Back and Shuffle Forward 
commands work similarly, except the movements are only one layer at a time. In 
other words, these commands move a selected object(s) one layer backward or 
forward, respectively, within a stack of objects.

Note

If you click on an object within a stack of objects, and Bring to Front 
or Shuffle Forward are not available in the Arrange Menu, then the 
object is already at the top of the stack.

If you click on an object within a stack of objects, and Send to Back or 
Shuffle Back are not available in the Arrange Menu, then the object is 
already at the bottom of the stack

Gloup/Ungloup

The Gloup command is similar to the “group” command commonly found in other 
graphics applications, except that with this command, the selected objects 
maintain their individual handles and central anchor points. If the objects were 
“grouped”, the way most graphics applications handle “groups”, the grouped 
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objects would only have a single central anchor point (instead of each object 
within the group having their own anchor point) and there would be one set of 
handles around the entire group (instead of each object maintaining their own 
individual handles). 

Objects having individual anchor points and handles instead of group anchor 
points and handles is integral to ObjectDANCER since it determines how objects 
can be manipulated. Glouping allows objects to maintain their individual 
manipulative ability after the “group” effect no longer makes sense (ungloup).

To gloup objects within ObjectDANCER, hold the [shift] key down while clicking 
on objects to be selected. Another way to select multiple objects in one movement 
is to drag the cursor from the outer area of the objects to the opposite corner of the 
area; a guide box will be temporarily drawn, until unclicking your mouse, whereby 
the objects within the box are selected. Then select the Gloup command from the 
Arrange Menu.

Center Anchor Point

The Center Anchor Point command (on the Arrange Menu) allows you to reset 
the x and y values of the anchor point so it is centered in the Compo Window. 
These values become available relative to the time of the current time (i.e., RCT 
line position) at which time this command is invoked.

Modifying Text

You are given three different ways to modify text within ObjectDANCER:

• via the options available through Type Menu

• via the Text Attributes palette (in the Hub)

• via the object attributes lists available when you have a text object’s attributes 
list expanded

The Type Menu offers you a number of options to edit text objects the way you 
want. After importing text into a project window, select a text object(s), and use 
the options from the Type Menu to modify it, as follows:
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Font    Allows the typeface (also known as font) of the selected text object(s) to be 
modified. By highlighting a different font within the font list (other than the one 
that is checked), you can change the font of a text object(s). If you do not see a 
font that you want, ensure that it is installed correctly on your system.

Size    Allows the size of the font of the selected text object(s) to be modified. By 
highlighting a different size within the font size list (other than the one that is 
checked), you can change the size of the text object.

Justify    Allows you to set the positioning of text within the text area established 
for the text object. The options Left, Center, Right, or Full are illustrated below:

Style    Allows different styles of a font to be applied to a selected text object(s). 
You can change the style of the text object by highlighting the style you want from 
the style list (other than the one that is checked). The style options are illustrated 
below: 

Using the Text Attributes palette or a text objects dancing attributes list to modify 
the text instead are other viable mechanisms to modify text objects. All 
mechanisms primarily work the same, although they are included within the 
software package to give you some flexibility in how you work with 
ObjectDANCER. 

Changing The Background Color

The BackGround Color... command allows you to change the background color 
of the Compo build window, and ultimately your animation. Depending on your 
system, you can have one, two, or more color models to select your background 
color from. Two common color models, an RGB (red-green-blue) model and an 
HSL (hue-saturation-lightness) model, are discussed here. RGB is a color model 
often used by those who work with video. Red, green, and blue light is mixed to 
achieve the colors visible to a video monitor.

Left Center Right F u 1 l

Plain, , , Underline, Condensed, Extended
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HSL is a color model often used by artists because it resembles the way artists mix 
colors on a palette. Hue describes the color pigment; saturation is the measure of 
color pigment present; and lightness refers to the amount of white in the color. 

By selecting this command, a window similar to Figure 4-2 or Figure 4-3 appears. 
Select the color model that suits your background best, if not already displayed.

To use the RGB color model (Figure 4-2), move the cursor over the red, green, and 
blue color rulers. Adjusting one ruler at a time, hold the mouse button down while 
dragging the handles on the red, green, and blue rulers; release the mouse button 
when the New color box displays the color that you want. As you adjust the rulers, 
the red, green, and blue percentile values are automatically adjusted.

Figure 4-2 BackGround Color...—RGB Color Picker Window

To use the HSL color model (Figure 4-3), move the cursor over the color wheel 
with your mouse; the cursor changes to a + sign. Drag the cursor over the color 
wheel, and release it when the New color box displays the color that you want. 
The hue, saturation, and lightness values are automatically adjusted. You can also 
adjust the color variations by dragging the handle on the color bar just beneath the 
color wheel to the left or right.
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Figure 4-3 BackGround Color...—HSL Color Picker Window

Note

Changing background color within ObjectDANCER is not currently 
animatable. However, if you wanted to animate the background, you 
could first create an object the same size as the compo build window, 
and create an animated background just as you would create any 
animation. Lock this portion of your animation with the Lock 
command (Arrange Menu), and then you could create a primary 
animation with objects lying over your created background animation.
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Chapter 5 l

Fine Tuning

Editing the Curve with Bezier Points

The curved motion between any two points of animation within your project is 
known as a bezier curve. The axis of the curve, where the curve actually bends, is 
known as a bezier point. Your animations will be made up of many bezier curves 
and points as you create the many different object paths within your project.

To edit, or even create a curve, between any two points in an object’s path, you 
have to add and manipulate bezier points within an object’s path. To describe this 
further, let us back track for a moment to our original animation in Chapter 2, 
where we created a movie with a “moon” object moving from the left to the right 
of the screen. If you recall, the movement was created by moving the current time, 
and then dragging the object to its new location, as in Figure 5-1.

Figure 5-1 Creating an Object’s Path
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Adding Bezier Curves

To create a curving, swooping movement of an object after you have created a 
basic object path, as in Figure 5-1, hold down [option] while clicking and dragging 
on the object’s path. The cursor will change to the add bezier point cursor with a 
plus sign, such as , as you drag the path line and add a bezier point and curve 
to the object’s path. 

Another way you can add a curve is to select the add bezier tool from the 
Toolbox Palette. This changes your cursor to an add bezier point cursor (instead of 
holding down the [option] key).

Figure 5-2 Adding a Bezier Point to a Path

When you create a bezier point, a tangent is created at the axis point of the curve. 
Specifically, the bezier point is the middle handle on the tangent, or the axis of the 
tangent line. The endpoints of the tangent are the bezier tangent endpoints. By 
dragging on any of the three bezier handles, you can manipulate and skew your 
bezier curve in many different formations.

Manipulating Bezier Points and Curves

As mentioned, by dragging any of the three bezier handles, the center bezier point 
or the tangent endpoints, in any direction, you can manipulate the dimensions of 
your bezier curve, and thus the object’s path, into many different curve formations. 
Since the movement of objects is the most critical part of making a smooth 
animation, clearly understanding all the many ways you can manipulate bezier 
curves is very important. Although trusting in your own creativity and 
experimenting with different manipulations by trial and error is probably the best 
teacher around. 

Figure 5-3 illustrates a number of different examples of how you can modify the 
bezier curve by dragging the bezier point or tangent endpoints. 
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Figure 5-3 Manipulating the Curve with Bezier Points and Tangent EndPoints

In Example 1, by dragging the center bezier point up or down, you can make the 
curve shallower or deeper, respectively. Example 2 shows how the curve widens in 
the curve section between the path’s endpoint and the center bezier point, or the 
curve could be made narrower if the tangent endpoint was dragged in the opposite 
direction. 

You can contort the path’s curve by dragging up on a bezier tangent endpoint, 
towards the center of the curve, as shown in Example 3. Example 4 shows that by 
dragging a tangent endpoint in a rotation of 180˚, and thus crossing the tangent 
line over the opposite side of the curve, you can create a looping bezier curve.

You can even add additional bezier points in an object’s path by selecting another 
area of the curve with the add bezier point cursor in the same way that you made 
the original curve, as in Figure 5-4.

Example 1: vertical movement of bezier 
curve (dragging center point)

Example 2: stretching a bezier endpoint 
(dragging right endpoint)

Example 3: contorting bezier curve 
(dragging right endpoint up)

Example 4: looping bezier curve (drag-
ging right endpoint 180˚)
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Figure 5-4 Adding Additional Bezier Curves along a Single Path

Deleting a Bezier Point

To delete a bezier curve, and return an object’s path to being straight again, as it 
was when the path was first created, select the delete bezier tool from the 
Toolbox Palette to change your cursor to a delete bezier point cursor, such as 

. By clicking on the center bezier point of the bezier curve, the bezier curve is 
deleted. 

Figure 5-5 Deleting a Bezier Point

Converting a Bezier Curve to an Angle

Another curve manipulation tool is the convert bezier tool which converts a bezier 
curve into an angle. To convert a bezier point, select the convert bezier 
tool from the Toolbox Palette to change your cursor to a convert bezier 
point cursor, such as . By clicking on the center bezier point of the bezier 
curve, the bezier curve is converted to an angle, as in Figure 5-6. 

BEFORE AFTER
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Figure 5-6 Converting a Bezier Curve into an Angle

Splitting a Bezier Tangent

You can also use the convert bezier tool to split a bezier tangent, and create 
a different kind of bezier angle. When you split a bezier tangent, you can create 
irregular paths for your objects to follow, where on one side of the path it may be 
curved, and at the center bezier point, the path takes a turn in a totally different 
direction. Again, the best way to illustrate this is with a picture, as shown in Figure 
5-7.

Figure 5-7 Splitting a Bezier Tangent

Converting a Bezier Angle to a Bezier Curve

To revert the bezier angle back to a bezier curve, select the convert bezier 
tool  tool from the Toolbox Palette again. By dragging on the angle point, 
the angle will revert back to a bezier curve. See Figure 5-8.

BEFORE AFTER

BEFORE AFTER
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Figure 5-8 Converting from a Bezier Angle to a Bezier Curve

Paste Special

ObjectDANCER offers a very powerful pasting command called Paste Special... 
(on the Edit Menu). This command allows you to take some or all dances from one 
object in your project, and paste them to another object, or selected group of 
objects.

The first and easiest way to use the Paste Special function is to drag a dancing 
object in the Synchro Window on top of another object within the Synchro 
Window. All attributes from the pasted-from object are inherited by the pasted-to 
object. The inherited keyframes in the pasted-to object are automatically left 
aligned. 

The second and more “special” way to use Paste Special is to select a dancing 
object (i.e., a paste-from object) from the Synchro Window (or library catalog in 
the Hub window) and copy it to the clipboard using the Copy command (or zC). 
Select a paste-to object(s), and then select the Paste Special... command from the 
Edit Menu. A Paste Special dialog box appears, where you can toggle which 
attributes you do or don’t want to paste onto the selected destination/pasted-to 
object(s), as illustrated in Figure 5-9.

BEFORE AFTER
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Figure 5-9 Paste Special Dialog Boxes

At the bottom of the Paste Special dialog box, you are presented with a keyframe 
alignment pull-down menu, with options to align the keyframes within the object’s 
dance bars. The keyframe alignment options are described as follows:

Proportional Keyframe    This option time stretches 
the keyframes to proportionally be distributed within the paste-to object’s dance 
bars. 

Left Align Keyframe    This option distributes the 
keyframes from the beginning (left side) of the object’s dance bars, with the same 
spacing as the paste-from object’s dance bars.

Right Align Keyframe    This option distributes the 
keyframes from the end (right side) of the object’s dance bars, with the same 
spacing as the paste-from object’s dance bars. 

Note

If the “paste from” object has a larger lifespan than the “paste to” 
object, then the keyframes will still be pasted to the “paste to” object, 
but the keyframe mushrooms will be placed outside of the object 
lifespan range.

...for text objects...for graphic objects
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Text Decompose

Another very powerful command is Text Decompose. This command allows you 
to take a single text object made up of one word or multiple words, and break it 
down to be single characters or single words, and hence, multiple objects. When 
the text object is broken down, each smaller component of the larger text object 
becomes an individual object with inherited dances from the original object.

To demonstrate how Text Decompose works, try it out in a “test” project, and 
follow these steps:

1. Import a text object into your project.

2. Select the text object within the Compo Window.

3. Select the Text Decompose command from the Arrange Menu (or press the 
 smart icon. The following dialog box appears.

Figure 5-10 Text Decompose Dialog Box

4. From the pop-up menu, select how you would like to segment the text object 
(e.g., by letters, by words, etc.). 

5. If you would like each new segment (text object) to have new anchor points at 
the center of each text object, select the Centered new anchor points option. 
Otherwise, all of the segments will have an anchor point in the same location 
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as the original text object. The following illustration shows how the anchor 
points are positioned differently with this option.

6. Then, click on OK and the text object is split into segments (e.g., letters, 
words, etc.) as specified, with each segment now becoming a separate object 
within the project. 

In the Compo or Synchro Window, you will notice an immediate increase in the 
number of objects, because of all the new objects that were created for each 
segment of the original object. These new text objects inherit all of the same 
dances of the original object, but may be manipulated and changed as single 
objects as well.

More on Keyframes

This section discusses manipulation techniques of keyframes. As you get more and 
more familiar with ObjectDANCER, you will gain a more thorough understanding 
for the importance of a solid understanding of keyframes. With this understanding, 
creating rich, powerful, and synchronized projects become easier and easier.

Moving Keyframes

You can easily move a keyframe to a new location by dragging the keyframe 
mushroom along an attribute’s dance bar. 

If you drag and move the very first keyframe mushroom of an attribute to the right 
along the dance bar, but still preceding the second keyframe mushroom, the object 
will still take on the first keyframe value at the beginning of the object’s life, even 
though it is not positioned at the beginning of the dance bar. Before the first 

(Selected original text. Note 

(“Centered new anchor points” option 

central anchor point.)

unselected. Note central anchor point 

(“Centered new anchor points” option 
selected. Note separate anchor 
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keyframe, the value of the attribute is the same as the first keyframe; after the last 
keyframe, the value of the attribute holds the last keyframe value.

Keyframes Outside the Object Lifespan

ObjectDANCER allows you to create keyframes outside of an object’s lifespan 
range. When creating a keyframe outside of the object lifespan range, the bar will 
appear lightened between the end of the object lifespan and the new keyframe 
outside of the keyframe. Such a keyframe will not be visibly or audibly animated 
within your project, unless the object’s lifespan were to be increased to include it; 
still the keyframe outside of an object lifespan still maintains it’s effect, and exist 
as a component of the project file (until deleted).

Duplicating Keyframes

Suppose you have an object that starts its life at a 0˚ rotation, rotates to 58˚ by 
adding a second keyframe, and you then want to rotate the object back to 0˚ again. 
One way to make the 0˚ rotation change would be to duplicate the first keyframe 
that establishes the 0˚ rotation initially. By holding down [option] while dragging 
on the 0˚ rotation keyframe mushroom along the dance bar beyond the 58˚ 
keyframe, upon releasing the mouse button and [option], you will have a 
duplicated 0˚ rotation keyframe in the new location. 

You can also duplicate a group of keyframes, like an established dancing pattern 
that you have created: hold down [shift] while selecting the keyframes you wish to 
duplicate, then press [option] while dragging the group of keyframes to a new 
location along the dance bar. Upon releasing the mouse button, the group of 
keyframes are duplicated in the new location with the same spacing between the 
keyframes as the original keyframes.

Finally, you can easily select all keyframes for duplication by clicking on one 
keyframe and then pressing zA (i.e., “select all”). All keyframes along the dance 
bar are selected. Press [option] while dragging the group of keyframes to a new 
location along the dance bar, and upon releasing [option], the keyframes have been 
duplicated.

Keyframes Locked or Adjust Left or RIght

If you change the size of an object’s lifespan by dragging on either end of an 
object lifespan bar, the existing keyframes positioned on the object’s lifespan 
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(notice the keyframe tags on the object lifespan bar) are automatically locked in 
place, and will not shift as you expand or decrease the size of the object’s lifespan. 
You can tell that the keyframes are locked because a small “lock”  appears 
over the keyframe tags on the object’s lifespan bar as you are changing the object 
lifespan size.

If you hold down [control] while dragging on either end of an object’s lifespan bar, 
the existing keyframes will move to the right or left (depending on whether you 
drag the lifespan bar to the right or left) by the exact amount of time that the 
lifespan bar was expanded by. A small right or left arrow appears over 
the keyframe tags, indicating the direction of the keyframe alignment. 

If you hold down [option] while dragging on either end of an object’s lifespan bar, 
the existing keyframes are distributed the exact amount of time that the lifespan 
bar was expanded by. A small double arrow appears over the keyframe tags.

Speed between Keyframes

You can control the speed between keyframes for all continuous-valued dances 
within your animation. By quickly double-clicking, then pausing, on the gray 
dance bar of a particular object’s attribute within the Synchro Window, a graphical 
illustration of the speed between keyframes is displayed, as shown in Figure 5-11. 

Figure 5-11 Speed between Keyframes 

The specific components of the Speed Variation Window are described as follows:

keyframe/bezier points    The bold black points along the speed slope indicate 
keyframes within a particular attribute’s dance. The time location of each keyframe 

keyframe/bezier points

speed slope/bezier curve

attribute value at cursor position

cursor time

easy in/out smart icons
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point is directly aligned with the time location of the corresponding keyframe 
mushroom along the attribute’s gray dance bar within the Synchro Window.

speed slope/bezier curve    The sloping of the connecting lines represents the 
speed between any two points, or keyframes. The steeper the slope of the line, the 
faster the speed between two keyframes. The flatter the slope of the line, the 
slower the speed between two keyframes. The distance between any two keyframe 
points along the speed slope directly correlates with the distance between the 
corresponding keyframe mushrooms along the attribute’s gray dance bar within the 
Synchro Window.

The easiest and most consistent way to edit the bezier curves is to use the smart 
icons at the top of the Speed Variation Window. Through using these short-cut 
icons, you are guaranteed smooth transitions between changes because the 
changes are “eased in and out”, or gradually accelerated/decelerated between 
changes.

Otherwise, the speed slope/bezier curve can be manipulated with the same tools 
and keystroke commands that used to manipulate an object’s path/bezier curve. By 
dragging on either of the tangent endpoints, you can skew the curve in any 
direction. By dragging the center bezier point, you can move the curve up and 
down, and (for all dances except position) you can also move the curve left and 
right. (Refer to “Editing the Curve with Bezier Points” beginning on page 75 for 
more details on manipulating bezier curves.)

attribute value at cursor position    This is the value of the attribute at the cursor 
position. 

cursor time    This time value represents the time location of the cursor, relative to 
the beginning of the attribute’s life (i.e., 00:00:00:00). As you move the cursor 
horizontally within the Speed Variation Window, the cursor time is adjusted to 
display the current time at any particular cursor position.

Controlling the Speed

You can adjust the speed, making the speed slope steeper or flatter, by dragging the 
keyframe points vertically up or down, or horizontally to the left or right. When 
you make horizontal keyframe changes, keep in mind that you are also moving the 
keyframe time positions within the animation. Notice how the keyframe 
mushroom moves along the attribute’s keyframe/dance bar (within the Synchro 
Window) when you move the keyframe point horizontally (left or right) within an 
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attribute’s Speed Variation Window. The speed slope is also adjusted, distributing 
the speed evenly relative to the slope, between the two points. 

You can also add additional keyframe points along the speed slope, just as you 
would add a bezier point while editing an object’s path. Use the same tools and 
keystroke commands that you would use to edit object paths to modify the speed 
slope (i.e., Hub tools, Synchro Window attribute lists). Just remember, that for 
every bezier point that you add or change in an attribute’s speed slope, a 
corresponding keyframe in the attributes’s gray keyframe/dance bar is 
consequently modified.

Note

You can open up as many Speed Variation Windows simultaneously as 
your want, so you can see how your changes to the keyframes’ speed 
affects other dances and objects, real-time, within the Compo or 
Synchro Window.

Time Alignment

Through the Time Alignment command on the Arrange Menu, you can align two 
or more object lifespan bars in your project. Click on the object lifespan bars you 
would like to align while holding down [shift], then select the Time Alignment 
command (The Time Alignment command will not be highlighted if two or more 
object lifespan are not selected first.). The following dialog box appears.

Figure 5-12 Time Alignment Dialog Box

You can align the object lifespan bars so they all start (i.e., left side) and/or end 
(i.e., right side) at the same time, or they are stepped in equal increments, or when 
one object lifespan ends, another one begins, or their start and/or end times 
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overlap. By selecting and inputting different combinations of settings within the 
Time Alignment window, the illustration on the right side of the window is 
modified to show how the setting would be implemented. 

These illustrations are conceptual only: the number of bars in the illustration do 
not necessarily match the number of lifespan bars that you have selected, and the 
incremental step positioning is not an actual measurement of the step as inputted 
in the settings. Nonetheless, they are a good guides to show how the bars will be 
aligned or configured relative to your inputted settings. The following sections 
describe the settings in more detail.

Starts/End    Establishes at what time the starts or ends of the lifespan bars will be 
aligned, if aligned at all. 

• Free - the positioning of either the start or end are left “free” or untouched; a 
specific value is not applied.

• Lock - the starts or ends will by locked, as specified, and remain unchanged. 
The handles are not locked permanently, but rather only while implementing 
the time alignment.

• By Value - you can input a specific time to position all starts or ends of the 
selected lifespans. If you have a positive or negative time value, the starts or 
ends of the lifespans will be stepped in equal increments or decrements, 
respectively, by the time indicated. 

Note

If the object lifespans’ starts are already aligned at 00:00:00:00 time 
position, and a negative time value is inputted in the Time value field, an 
error message will appear, disallowing such an alignment because there 
is no available time to decrement the object lifespans. If you drag the 
selected object lifespans to the right a little, to allow space, then you 
will be able to decrement step the lifespans. 

KF Align    This option, available for input only when both the object lifespan 
starts and ends are being aligned, will equally distribute the keyframes within the 
objects’ lifespans.

• Start -This option distributes the keyframes from the starts (left side) of the 
objects’ lifespans. 
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• End - This option distributes the keyframes from the ends (right side) of the 
objects’ lifespans. 

• Life - This option stretches the keyframes to proportionally be distributed 
within the objects’ lifespans. 

within the object’s dance bars. The keyframe alignment options are described as 
follows:

Overlap    Allows the starts or ends of the selected lifespan bars to overlap by a 
specified amount of time.

Elements selected    Indicates the number of object lifespans that are selected for 
alignment, which is not related to the representation in the graphical representation 
beneath this value. The graphical representation is conceptual only.

Figure 5-13 illustrates a number of sample alignments to give you an even better 
feel for how to set the Time Alignment settings. The best way to truly understand 
time alignment, however, is through trial and error within a test project. After 
inputting only a few different time alignment configurations, you will quickly be 
able to see how the object lifespans are aligned relative to one another (and 
remember, you can always use the Undo command if you input the wrong 
alignment values inadvertently).

Figure 5-13 Time Alignment Scenarios

Start (0)
End (0)

Start (0)
End Free

Overlap (0)

Start (0)
End Free

Start (-2)
End Lock

Start (2)
End (-4)

Start (2)
End (2)

Start (2)
End Lock 

Overlap (-2)

Overlap (2)
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Keep in mind that when a value is inputted, the graphic is conceptual only, 
showing the layout of the objects’ lifespan bars, not the actual incremental spacing 
as specified by the inputted value (if any). Similarly, the representations of Lock 
start/end setting, as depicted in the illustrations, are not depicting the actual 
positions of the bar ends (or starts), but rather just that the starts or ends are locked 
in their current positions, whatever those positions might be.

Object Lifespans Beyond the Synchro Window Viewing 
Area

To view object lifespans and dance bars that extend beyond the Synchro Window’s 
viewing area after setting a new time alignment of some object lifespans, you can 
maneuver the screen to view more of your project. These mechanisms become 
very useful when your project becomes complex. The following are a few 
alternatives to adjust your Synchro Window’s viewing options:

• Click on the scroll bars on the right-hand side of the screen, or at the bottom 
of the screen. By dragging on the scroll bars, you can adjust the Synchro 
Window’s viewing area.

• Click and hold the mouse button down on the window size box to drag the 
window to be larger (or smaller) and to allow more dance bars to be displayed 
when the Synchro window objects are expanded.

• Click on the zoom tool to increase the scale ratio of the Synchro Window. 
When you increase the horizontal scale ratio, even though you can view a 
longer duration of time, your object lifespans will appear smaller due to the 
larger view ratio, making keyframe edits more compacted as well. To decrease 
the horizontal view ratio, press [option] while clicking on the zoom tool.

• Use the hand tool as an assimilated scroll mechanism, similar to the scroll 
bars. With the cursor in the Synchro Window, hold down the [space bar] and 
the mouse button. When your cursor changes to a fist , you can scroll the 
window area inside the Synchro Window any which way you want—up, 
down, left, or right, as needed. 

Visual Alignment

The Visual Alignment command allows you to align selected objects amongst one 
another within the Compo Window. When you select this command from the 
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Arrange Menu, the following palette is displayed. Figure 5-14 also includes the 
horizontal and vertical pop-up menus look (when opened).

Figure 5-14 Visual Alignment Palette

This palette is quite powerful in itself, and very easy to use because for every 
horizontal or vertical alignment option or combination of options, the graphical 
display on the palette is adjusted with a conceptual image of how the objects 
would be aligned. You can align two or more selected objects within the Compo 
Window (if you try to align only one object, the “Apply” button is disabled). Also, 
because this is a palette, you can keep the palette open on your desktop at all times 
while working.

Before applying a visual alignment, select different combinations of the alignment 
options until you achieve the placement that you are looking for. The term 
“distribute” among the various options means that the positioning would be 
distributed evenly between the different selected objects and relative to where the 
objects are being distributed from (i.e., top, bottom, right, left, center) within the 
Compo build window. For example, the horizontal option “Distribute from center” 
will distribute all the objects’ center points evenly across the Compo Window, but 
without regard for the objects’ different sizes. If an object is significantly wider 
than another within the alignment selection, the objects may end up overlapped. 
“Distribute by widths” might be a more appropriate selection for this type of 
scenario because this option takes into account the varying widths of the selected 
objects, and distributes the objects’ space between each other so the spacing is 
evenly distributed between each other regardless of object size. 
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Audio Synchronization

You can synchronize audio objects’ patterns with other dancing objects within 
your project, such as graphics or text, using one of ObjectDANCER’s Audio 
Marking Windows. Through these windows, you can play an audio file, select 
shortened segments of an audio file for playback within your project, loop a 
certain segment of an audio file, or add markers to synchronize your audio with 
other objects within your project.

Since ObjectDANCER supports different types of audio files (i.e., AIFF, WAV, and 
MIDI), there are also different types of Audio Marking Windows for 
synchronizing the different types of audio within your project. After importing an 
audio file, the format of the file is easily identified in your project through an audio 
object icon located to the left of audio object labels in the Synchro Window. An 
AIFF or WAV audio object’s icon looks like this: . An imported MIDI file’s 
icon looks like this: . 

Digital Audio or MIDI files

Generically referred to as digital audio, AIFF (Audio Interchange File Format) or 
WAV files have a very different format than MIDI (Musical Instrument Digital 
Interface) files, which is why these filetypes are treated separately.

Digital audio is an actual representation of sounds that are stored as thousands of 
individual numbers, known as samples. Its graphical representation looks like 
waves across a screen, where the high and low parts of the waves represent the 
different pitches in the playback of the audio. When there are two wave streams, 
the audio was recorded in stereo channel; a single wave stream indicates that the 
audio was recorded in mono channel. Digital audio data, once recorded and saved, 
will playback with the same recorded quality, and on most audio devices. 

MIDI files, on the other hand, include a list of time-stamped musical chords with 
the sounds coming from either different computer generated instruments, or real 
instrument samples, depending on the recording or playback device. Although the 
quality of MIDI files largely depends on the recording and playback devices, MIDI 
files can often be very high quality, with complex and impressive sounds, while 
requiring significantly less memory and having very low bandwidth on the 
Internet, compared with digital audio. 
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The following table describes the pros and cons of using digital audio or MIDI 
files in more detail. Regardless of your choice, ObjectDANCER supports both 
formats. 

Table 5-1 Pros and Cons of Digital or MIDI Audio Files

Audio File 
Format Pros Cons

MIDI • Compact file sizes which are 
completely independent of playback 
quality (i.e., 200 - 1000 times smaller 
than CD-quality digital audio).

• Low RAM and hard drive impact.

• Sometimes higher quality than digital 
if recording and playback device is 
high quality.

• Able to change the length of file 
without changing pitch or quality.

• Very precise editing abilities (i.e., 
possible to edit down to an individual 
note).

• Easy to learn musical notes and 
rhythms because of color coded 
graphical representation.

• Low bandwidth on Internet. 

• Stereo and mono MIDI files are about 
the same size files.

• Musical audio only; no spoken 
dialog.

• Device dependent: playback on 
MIDI compatible devices only 
(e.g., MacOS, PCs with an 
installed sound card, etc.). 

digital audio 
(AIFF or 
WAV)

• Consistently has very high playback 
quality, regardless of playback device.

• More popular for multimedia 
productions due to reliable quality.

• More cross-platform applications 
support digital audio.

• An understanding of musical theory 
is not necessary.

• New compression processes are 
continually being developed.

• Cannot edit musical components 
of a composition, as you can 
with MIDI.

• Very large file sizes.

• Heavy on RAM and hard drive

• Stereo files are about twice the 
size of mono files.
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Audio Marking Windows

Audio Marking Windows are provided so you can add audio markers at certain 
points during an audio’s playback, which can later be synchronized with different 
object dances within your project. The Audio Marking Windows for the different 
audio file formats are fairly close in features, except in three ways:

• The graphical representations of the audio sampling sequences are very 
different: digital files (AIFF or WAV) are represented with wave-like 
formations across the window. MIDI files are represented with line segments 
that are color coded for different musical instruments, and different lengths 
for the playtime duration of each instrument.

• Digital files can be “scrubbed”, meaning that by dragging your clicked mouse 
button in the audio sampling window as slow or fast as you want, you can 
manually play, or scrub, the audio. This mechanism is very useful when 
attempting to add very precise markers to your audio file for synchronization 
with other objects in your project.

By double-clicking on an audio object’s icon or object lifespan bar, a window 
similar to Figure 5-15 or Figure 5-16 will be displayed, depending on whether you 
are opening a digital AIFF or WAV audio object , or MIDI audio object , 
respectively.
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Figure 5-15 Digital Audio (AIFF or WAV) Marking Window

Figure 5-16 MIDI Audio Marking Window

The different components of the Audio Marking Windows are described in more detail in 
the following sections.

play/pause

loop stop scrub

snap/drag loop

snap play/
current time

IN/OUT adjustment handles -
allows you to easily expand or
decrease the audio output bar.

audio output bar - adjustable blue bar
defines the area of the audio object

lifespan bar in the Synchro Window.

current time - current time is
indicated in three areas. RCT

indicator line scrolls horizontally
while audio plays.

sound marker maker - click on this to 
make sound markers. Sound markers 
can then be labeled to specify 

horizontal auto-scroll - automati-
cally scrolls screen to keep pace with 
rolling current time indicator while 
audio is playing.

control buttons - allows you to control audio file 
playback, so you can add synchronization sound 
markers, or just listen to the selected audio file.

cursor time - indicates
location of the cursor in the

Audio Mar king Window (notice
cursor time, and location

of cursor).

digital audio sampling sequences - 
double waves indicate stereo; single 
waves indicate mono audio.

current time

play/pause

loop stop

cursor time

snap/drag loop

snap play/
horizontal 

sound marker maker

control buttons

IN/OUT adjustment handles audio output bar

MIDI audio 
sampling sequences

auto-scroll
current time

scrub
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current time    The current time in the Audio Marking Windows is conceptually 
the same as the current time in the Compo and Synchro Windows. Within the 
Audio Marking Windows, the current time represents the actual time of playback 
of an audio at any given time (or the actual time the audio was paused or stopped, 
as the case may be). 

The current time is reflected in three different places in the Audio Marking 
Windows: 

• As the RCT indicator line that scrolls throughout the play window while an 
audio is playing.

• In the red current time timestamp just above the RCT indicator in the upper 
ruler.

• In the red numerical time just above the control buttons bar.

cursor time    The cursor time reflects the horizontal location of the cursor, as 
measured by the upper time ruler within the Audio Marking Windows.

sound marker maker    This tool is for marking significant audio points in your 
project that you may want to use for synchronization with other objects in your 
project. These markers show up also along an audio object’s lifespan bar within 
the Synchro Window for future synchronization efforts. 

The sound marker maker works very similar to the timing marker maker, except 
that you can set sound markers “on the fly” as well. This mechanism is especially 
appreciated when attempting to mark very precise moments in an audio. The 
following bullets describe different ways that you can manipulate blue sound 
markers in more detail:

• To add a blue marker “on the fly” as an audio is playing, hit the [space bar] 
and a marker will be added just below the timeline ruler in the upper portion 
of the Audio Marking Window. The new marker is placed in the location of 
the RCT indicator at the time that the [space bar] is hit.

• Another way to add a blue marker is to drag the RCT indicator along the gray 
timeline bar to where you want to place the new marker, and then click on the 
sound marker maker icon. 

• To move a blue marker to another location, drag it along the gray timeline bar 
to a new location. Since the markers are automatically numbered, if you move 
the first marker to the end of a row of markers, all the markers will be 
renumbered to remain sequential.
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• To add brief annotations to a blue marker, double-click on a positioned blue 
marker. When the black highlight shows in the upper gray bar, type in a brief 
annotation. To close the annotations, click on the marker again, or click 
anywhere else within the window and press [return].

• To quickly jump the RCT indicator to a marker location, regardless of whether 
the audio is playing or not, either:

• Click on any positioned blue marker, and the RCT indicator snaps in 
alignment with the blue marker, or 

• For markers from 1 to 9, enter the number and the RCT indicator snaps 
to the numbered marker location. For markers greater than 9, enter the 
number while holding down [shift]. Upon releasing [shift], the RCT 
indicator snaps to the numbered marker location. 

• To select a specific marker among multiple positioned markers, click and hold 
the mouse button down on the upper gray bar. A list of positioned markers 
will be displayed; select the marker you want, and the RCT indicator will 
quickly jump to it.

• To delete a positioned blue marker, click and drag the blue marker out of the 
gray bar area, and it will disappear. If the RCT indicator is aligned with the 
blue marker when you are trying to delete, drag the RCT indicator out of the 
way before trying to delete the blue marker.

audio output bar    The audio output bar is an adjustable blue bar which defines 
the area of the audio object’s lifespan bar in the Synchro Window. For example, 
suppose you have a 50 second audio file, and your project is only 30 seconds. By 
decreasing the length of the audio bar to 30 seconds of the total audio, only the 
audio segment within the specified 30-seconds range will be played (although your 
project will still hold in memory the complete audio file). 

• To adjust the duration (length) of the audio output bar, drag on the purple IN/
OUT adjustment handles to the desired duration. As you drag on the left or 
right ends, the cursor changes to  or , respectively.

• To adjust the location of the audio output bar (which may be different than 
the beginning of the gray timeline ruler), drag on the middle of the bar; the 
cursor will change to  as you drag the bar to a new location along the gray 
timeline ruler.

IN/OUT adjustment handles    These purple handles at the ends of the audio 
output bar allow you to adjust the duration (length) of the audio output bar. By 
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dragging on either handle, you can expand or shorten the range of the bar. The 
cursor changes to when dragging the IN handle (left-most handle); the cursor 
changes to when dragging the OUT handle (right-most handle). 

control buttons    The control bar buttons collectively allow you to manipulate 
your audio file’s playback so you can add synchronization sound markers, or even 
just listen to the selected audio file. 

loop button    By clicking on this button, you can play the audio file 
over and over again, in a continuous loop. This is useful when you are adding 
markers “on the fly” by pressing the [space bar] to add a marker, and you want the 
music to play through first to add the markers, and perhaps again to double-check 
the placement of the markers. Once the loop button is selected (highlighted), the 
audio file will continue to play in this mode until it is turned off. Click on the loop 
button again to deselect/unhighlight it.

play/pause button    This toggle button between Play and Pause 
allows you to begin playback of an audio file from wherever the current time is 
located, and then Pause the playback when desired. To play again after the audio 
has been paused, click on the Play button again. 

If you Pause the audio, even though the Loop Play button is highlighted, the audio 
will remain paused until you resume the playback with Play.

stop button     This button halts an audio file’s playback that has been 
previously started with Play, and returns the current time to the beginning of the 
audio. 

snap play/current time    When this button is highlighted/activated, 
you can play the audio from any location in the audio playback window. Hold your 
mouse button down at any location in the audio playback window, and the audio 
will play from that location. Upon releasing the mouse button, the RCT indicator 
will jump to that location.1 

You can also use this feature to snap the current time within the audio playback 
window to any location that you want by clicking at any location. The RCT 
indicator snaps to the location. If you subsequently want to play the audio from 
that location, click on the Play button.

1. Anytime you drag the cursor over the audio playback window, the cursor is changed to .
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snap/drag loop    When this button is highlighted/activated, you can 
play small excerpts of an audio file in a loop. By holding your mouse button down 
at any location within the audio playback window, the RCT indicator snaps to that 
location, and an excerpted portion of the audio file is highlighted, and begins to 
play in a loop. The current time of the loop playback highlighted area is indicated 
by a moving white line which loops within the highlighted area as long as you 
hold your mouse button down. Figure 5-17 illustrates the snap/drag loop feature.

Figure 5-17 Snap/Drag Loop Highlighted Excerpt Example

You can drag the highlighted selection to find a specific part of an audio; or, you 
can unclick, then click in a new area of the audio, and the highlight (and RCT 
indicator) will snap to the new location. 

To increase or decrease the highlighted loop selection, while your mouse button is 
unpressed, hold down the [shift] key and drag the highlighted area to a desired size.

scrub button    This button, which is available only in digital Audio 
Marking Windows (AIFF or WAV files), allows you to manually play the audio by 
dragging the cursor with your mouse button pressed as slow or fast as you want. 
The audio will sound muffled, but audible and recognizable, as you scrub, or 
manually play it. This mechanism is very useful when attempting to find a precise 
location in your audio so you can add an sound marker for synchronization with 
other objects in your project.

horizontal auto-scroll    This button allows your play window to follow 
along with the red current time indicator as it scrolls horizontally during playback. 
Without this button highlighted, the audio still plays, but the red current time 
indicator scrolls horizontally out of the playback window’s range.
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Chapter 6 l

Final Steps

Congratulations! If you have gotten this far in your project effort, you truly have 
entered the final steps, the point at which all your time and effort—your 
animation—will finally come to life in a movie. 

This chapter discusses the output functions, ranging from showing a basic preview 
before creating a movie, to printing a scene from you movie, and everything in 
between. ObjectDANCER gives you several options on how to output your 
animation: QT movies, including GX or sprite movies, JAVA animations, and 
animated GIFs. 

All output settings that you establish on a project are saved as part of the project 
definition, and so therefore each project’s output options need to be carefully 
selected.

Options...

Through the Options... command on the Output Menu, you have a number of final 
decisions to make regarding your project and how you would like it to be output, 
and depending on the type of output that you select. There are four sub-menus, 
which are described in further detail directly following this short section:

• QT Compression... - includes QuickTime compression algorithms to allow our 
project to run more efficiently. 

• GIF... - Includes specific parameters and settings for outputting animated GIFs.
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• JAVA... - Includes specific parameters and settings for outputting JAVA 
animations.

• Audio... - Includes specific parameters and settings for an project that includes 
an audio component.

QT Compression

The first step before outputting you final project is to evaluate which QuickTime 
compression algorithm will work best for the type of production that you are 
creating. Selecting the best movie compression mechanism, or codec, is one of the 
most crucial parts of your animation authoring effort. 

Codecs, defined simply, allow your movie to be compressed in size while stored, 
and then quickly decompressed “on the fly” during your movie’s playback. To 
access the QuickTime compression mechanisms, select the Options... command 
on the Output Menu; click on the settings... button, and the following dialog box is 
displayed.

Figure 6-1 QuickTime Compression Window

Selecting the right codec for your movie can mean the difference between smooth 
playback or sluggish broken playback, high quality images or blurry poor quality 
images, reasonably sized movies or very large memory consuming movies. 
Although there are no established formulas or firm rules to tell you which 
compression mechanism will be the best for your project, since much depends on 
the varying elements that make up your project, the following discussion offers at 
least a few guidelines to work by.

The options in this pop-up are 
dependent upon the compressor 
selected.
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The compression schemes included with ObjectDANCER are standard software-
based QuickTime Compression schemes1. These codecs are: Animation, Cinepak, 
Component Video (YUV), Graphics, Photo - JPEG, and Video. Even though these 
codecs are standard, the final output of different compressed project movies 
created with different compression schemes vary dramatically. Different types of 
media in your projects will cause mixed results with the different compression 
mechanisms, and often different projects have very different levels of acceptable 
compression requirements. Because of all these variances, there are multiple 
codecs required for compression.

In general, the codecs differ in their compression ratios, and in the degree of 
preserved image quality levels. Compression ratios equate to the size of an original 
image divided by the size of a resulting compressed image. Typically, the higher 
the compression ratio is, the lower the quality of the decompressed image will be. 
If very high quality images are required, the cost is accrued in significantly slower 
compression and decompression time, as well as having a high memory impact. 

The supported different compression schemes are compared in Table 6-1: 

1. You can also use hardware based codecs if you have a hardware compression board installed 
on your system. Keep in mind, however, that if you use a hardware codec, you will probably 
limit your audience, since playback devices must have the same hardware codec installed.

Table 6-1 Comparing QuickTime Compression Schemes 

codec Description Recommended Usage

None • No compression.

• Images and quality remains untouched.

• What you see is what you get.

• When you have plenty of memory

• When you need the best quality.

Animation • Based on RLE (Run Length Encoding).

• Generally operates in a lossless mode: it 
preserves the original data completely 
with no degradation. 

• Compression ratio is 2:1 or better.

• Good for animated graphics without 
photo-realistic images.

• OK for informal movies, when settings 
are set high.
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By selecting a Compressor type within the Compression window, the Quality and 
Motion values are automatically adjusted appropriately to the particular chosen 
Compressor. It is recommended that you test the different types of compressors 

1. Prior to QuickTime 1.6, CinePak was known as “Compact Video”.

Cinepak1 • Better capabilities in image quality, 
playback size, frame rate and digitized 
video compression compared with the 
Video compressor. 

• Extremely slow compression rate, but 
that which is made up for with a very 
good decompression speed.

• Can easily provide frames sizes of 
320x240 pixels with a frame rate of 24 
frames per second.

• Excellent quality for 16-bit or 24-bit 
productions.

• Use for your final production, but not 
recommended for interim versions 
because of extremely slow compression 
rate.

• Most common codec used for high-end 
professional productions, like retail CD-
ROMs, sales videos, etc.

Component 
Video (YUV)

• Stores data in YUV 4:2:2 format. 

• Extremely high quality with a 
compression ratio of 2:1.

• Useful for certain video input 
productions.

• Also used as an intermediary storage 
format when applying multiple effects 
or transitions to an image.

Graphics • Similar to Animation codec, except 
optimized for 8-bit graphics.

• Accelerated compression speed, but a 
reduced decompression speed. 

• 8-bit still images, at best, because of 
very slow decompression.

Photo-JPEG • Maintains very high quality images 
image through decompression, although 
slow.

• Compression is slow as well., but for 
small photo-type clips, this rate is 
acceptable.

• Fixed images or digital photography.

• Slide show-style movies, at best, 
although the image quality and 
compressed file size is very good.

Video • Most common QuickTime codec (along 
with animation).

• Decent compression image quality, file 
size, compression and decompression 
rates.

• Good playback at a rate of 15 frames 
per second in a 160x120 pixel window.

• Relatively good all-around codec for 
capturing natural video images.

Table 6-1 Comparing QuickTime Compression Schemes (continued)

codec Description Recommended Usage
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since different compressor schemes can vary dramatically given different media 
types that comprise your movie.

Selecting Color Depth    Just below the compressor choices on the QuickTime 
Compression dialog box is a color depth pop-up menu. The available options in 
this pop-up menu vary with the different selected compressors. 

However, since your selection in this area ultimately affects how your movie is 
compiled, putting a bit of thought into this selection is worthwhile. As a general 
rule, select a color depth option based on what the primary playback displays can 
take advantage of (if you have this information). For example, if your audience 
will definitively be working with 8-bit monitors (256 Colors), it makes absolutely 
no sense to select a color option any higher than that, such as “Thousands of 
Colors” or “Millions of Colors”. Save these options for television-types of media, 
or high-end professional productions, respectively. The audience will gain no 
benefit from a higher selection, and if anything, a higher unused setting will only 
adversely affect the performance of your movie in other areas.

Quality Slide Ruler    Establishing efficient compression settings is a difficult goal 
to achieve since you will always be trapped in the desire for high quality images 
without high overhead demands. Unfortunately, this desire is pretty close to a 
dream, since reality holds that the higher the quality of preserved image quality, 
the larger your movie’s file size will ultimately be. Furthermore, even if you can 
tolerate memory intensive files, such files still might have impeded playback 
cycles.

Although you could certainly benefit from testing different settings within the 
Quality Slide Ruler if you have the time, keeping the ruler setting in the mid-range 
is probably going to provide you with the most reliable results. In fact, often the 
difference between a high quality setting and a medium setting will only be 
noticeable in file size, not image quality (again, depending on the codec used). 
Often sliding the ruler to extremes, such as the “Least” and “Most” settings, does 
not provide you with the extreme compression savings or quality improvements, 
respectively, as you may expect.

Frames per second setting    Setting the Frames per second value, otherwise 
known as frame rate, should also be geared towards your audience, and the types 
of machines that your movie will be run on. As a general rule, if you audience is 
wide, and your production will be played on multiple types of machines, 15 fps is 
probably a suitable rate for most machines, while not including too much overhead.
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If your production is higher end though, using 25 or 30 fps is probably more 
appropriate because chances are the playback machine will also be higher end, 
with a faster CPU, hard drive, CD-ROM speed, color depths, etc. Choosing a high 
rate when you know your production will be played back on lower end machines, 
however, only unnecessarily increases the file size, and compression and 
decompression time with no visible benefit to the production.

Again, the best way to select the right frame rate setting for your movie is by trial 
and error. If you select 15 fps, and compile your movie, and it appears too jerky or 
sluggish, try again with a higher setting until you reach a setting that is satisfactory 
to you. It is only important that you start out slow, and gradually increase, instead 
of the other way around, so you can adjust only to the appropriate speed level, not 
beyond.

Key frame every ____ frames setting    This value is for setting the QuickTime 
movie keyframe rate. To select a value to input here, again trial and error is the 
best choice. A good general purpose setting is equal to the Frames per second 
setting, and then you can adjust the value from there after a trial or two. 
Depending on if your project is highly animated or relatively constant, adjust your 
keyframes setting to be lower or higher, respectively. The lower the value, the 
higher the quality, but also the lower the performance and larger the file size.

Limit data rate to ____ K/seconds setting    This option, which is highlighted 
only when the Cinepak (or other codecs that support this feature) codec is selected, 
is a useful option to constrain the data rate of your final movie to a value 
acceptable for CD-ROM playback, such as a value of 90 to 100K/second. If you 
are not concerned with accommodating older and slower CD-ROM devices, enter 
a value of 180 to 250K/seconds. If your movie has sound, you may want to 
increase this rate even more, to like 150 or 300, respectively, depending on the 
target audience.

GIF Output Options

If you are creating an animated GIF, you will want to evaluate the GIF... options 
available through the Options... command on the Output Menu; as displayed in 
Figure 6-2.
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Figure 6-2 GIF Options Dialog Box

Palette Colors    This setting establishes the color palette to be used for images 
saved in your GIF animation.

Transparent Color    This setting defines the transparency of animation’s 
background. If you select the Color Picker Color option, the transparency color 
will be the color selected in the Color Picker window at the time of output. 
Therefore, if you change the color picker color after selecting this option, the 
newly changed color will take affect if you output directly after as well. 

Dithering and/or Interlaced    These toggle options allow you to adjust how your 
images are drawn on your screen (and ultimately within your outputted animated 
GIF). 

More specifically, dithering refers to when your system color palette does not have 
a color that is in an image in its palette. With dithering is selected, the palette will 
mix colors to approximate the needed color. If dithering is not selected, the color 
palette will not mix colors, but rather use the closest color available on the palette.

Interlaced refers to the order of the image lines to be drawn on your screen when 
the animation is being played back. When interlaced is selected, the even lines of 
the image are drawn first, and then the odd lines of the image are filled in. When 
interlaced is not selected. the lines of the image are drawn consecutively, one right 
after another.
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Frames per second    This setting is similar to the Frames per second (FPS) 
setting for QuickTime movies, only this setting refers specifically to animated 
GIFs. It is, literally, how many frames should be played per second upon 
outputting your animation. 

Refer to the explanation of the FPS setting for QuickTime movies on page 105 for 
further tips on what might be an appropriate setting. Also, as with all of the 
settings, trying different settings and then outputting your animation, is the best 
way to see how it affects your animation. 

Loop    This setting established how many times to loop (i.e., replay) your 
outputted animation, if at all. Select the Forever option if you want your animation 
to be in a continual loop, or specify a number if you want your animation to loop 
only a specified number of times.

Optimize    This option allows you to optimize your animation when you have 
specific images that do not change a lot throughout the duration of your animation 
(and, hence, between multiple keyframes). Without the optimize setting selected, 
every image will be redrawn for every keyframe, regardless of whether the 
attributes of the image have changed or not. This makes for a much larger sized 
final outputted animation (i.e., larger memory requirements), but a guaranteed 
exact animation. If you optimize, however, images are only drawn each time the 
image actually changes in the animation. 

Although upon first impression, optimization may seem desirable (i.e., smaller file 
size), the way the transparency background affects images that are not continually 
redrawn may give you some undesirable affects. Again, the best way to be sure is 
to output your animation both with and without optimization selected to find out 
which way makes the most sense for your specific GIF animation.

JAVA Output Options

If you are creating a JAVA animation, you will want to evaluate the JAVA... 
options available through the Options... command on the Output Menu; as 
displayed in Figure 6-3.
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Figure 6-3 JAVA Options Dialog Box

Show Images    This setting allows you to define how you want your images 
displayed as your JAVA animation loads to be played back. If you select ...while 
loading (slower), the images will be displayed in pieces while the JAVA animation 
is loading. This mechanism is slower. If you select ...after loaded (faster), the 
JAVA animation will not display anything until all images are loaded. This 
mechanism is more efficient, and sometimes seems to have a cleaner affect.

Palette Colors    This setting establishes the color palette to be used for images 
saved in your JAVA animation.

Transparent Color    This setting defines the transparency of the images saved in 
your JAVA animation. If you select the Color Picker Color option, the 
transparency color will be the color selected in the Color Picker window at the 
time of output. Therefore, if you change the color picker color after selecting this 
option, the newly changed color will take affect if you output directly after as well.

Dithering and/or Interlaced    These toggle options allow you to adjust the images 
saved in your JAVA animation. 

More specifically, dithering refers to when your system color palette does not have 
a color that is in an image in its palette. With dithering is selected, the palette will 
mix colors to approximate the needed color. If dithering is not selected, the color 
palette will not mix colors, but rather use the closest color available on the palette.
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Interlaced refers to the order of the image lines to be drawn on your screen when 
the animation is being played back. When interlaced is selected, the even lines of 
the image are drawn first, and then the odd lines of the image are filled in. When 
interlaced is not selected. the lines of the image are drawn consecutively, one right 
after another.

Type    This setting defines how your JAVA animation will be played back with 
respect to timing. If you select Draw All Frames, the animation will play back 
each frame of your animation regardless of how long it will take to do so. If you 
select Respect Timing, the animation will skip frames, if necessary, but will respect 
the overall duration. With Draw all Frames, you must also define how many 
frames per second you want drawn.

Loop    This setting established how many times to loop (i.e., replay) your 
outputted animation, if at all. Select the Forever option if you want your animation 
to be in a continual loop, or specify a number if you want your animation to loop 
only a specified number of times.

Export Java classes option    Upon installing ObjectDANCER, a set of JAVA 
classes are created on your system in the ObjectDANCER folder. These classes are 
needed for running any JAVA animation, and must be co-located in the same folder 
as your outputted JAVA animation’s HTML file. These classes can be used again 
and again, as long as the HTML files are always located in the same folder. If you 
would like to keep your animations separated in different folders, however, and 
highly transportable because the JAVA classes files are always kept together with 
the JAVA classes files, you can create a new set of JAVA classes for each and every 
newly outputted JAVA animation by selecting this toggle option.

Audio Settings

If you have a project that contains an audio object(s), then you will want to 
evaluate the Audio... settings available through the Options... command on the 
Output Menu; as displayed in Figure 6-2.
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Figure 6-4 Audio Settings Dialog Box

sample size pop-up    This setting captures the audio resolution of your audio. It 
can be set to 8-bit or 16-bit, whereby 8-bit sound is similar to tuning in to an AM 
radio channel, and 16-bit sound is CD-quality. In selecting the sample size for your 
audio, consider your audience’s playback mechanism. 16-bit sound is supported by 
most Macintoshes these days, but non-Macintosh equipment may require 
additional hardware to support 16-bit sound (or sometimes the mechanism will 
automatically playback a 16-bit audio at 8-bit quality). On the Macintosh, 16-bit 
playback requires Sound Manager 3.0, which is already installed on PowerMac 
machines, but not necessarily lower-end machines. 16-bit quality also consumes 
more memory, of course.

sample rate pop-up    Use this pop-up to determine how many sound samples per 
second that you want to the audio playback at. The higher the selected rate, the 
better the quality of the sound. On the other hand, the higher the selected rate, the 
heavier the audio is on disk space.

channels pop-up    This pop-up menu allows you to set mono or stereo channels 
for your audio. If your project is intended for playback on a stereo system, with at 
least two speakers, then stereo sound is certainly the way to go, despite its heavier 
demand on memory. If the playback machine is anything less, then do not bother 
with stereo. Without two speakers, the audience will not be able to hear the 
difference, so you might as well save memory and select mono.

A key thing to consider when establishing your audio settings is the significant 
amount of space required for audio. Audio files tend to be very large in size, no 
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matter what. Table 6-2 lists typical memory usage required for a one minute audio 
clip saved at different quality levels. 

Table 6-2 Storage Requirements for Digital Audio at Standard Sampling Rates
 

Sample
Rate

Sample
Size Channels approx. bytes 

for one minute Notes/Usages

44.1 kHz 16-bit Stereo 10.6 MB CD-quality

44.1 kHz 16-bit Mono 5.3 MB voice-overs

22.254 kHz 8-bit Stereo 2.7 MB

22.254 kHz 8-bit Mono 1.4 MB

22.05 kHz 16-bit Stereo 5.3 MB Darker sounding than CD, 
but still high quality.

22.05 kHz 16-bit Mono 2.7 MB Good for speech 
recordings.

22.05 kHz 8-bit Stereo 2.7 MB OK stereo sound. 

22.05 kHz 8-bit Mono 1.4 MB TV set sound quality. 
Good for background 
music and voice.

11.127 kHz 8-bit Stereo 1.4 MB

11.127 kHz 8-bit Mono .7 MB

11.025 kHz 16-bit Stereo 2.6 MB

11.025 kHz 16-bit Mono 1.4 MB AM radio quality; good 
for background music.

11.025 kHz 8-bit Stereo 1.4 MB At this rate, why even 
bother with stereo; seems 
self-defeating at a cost of 
more memory.

11.025 kHz 8-bit Mono .7 MB Pretty badly muffled.

7.418 kHz 8-bit Stereo .9 MB Stereo is completely 
ineffective.

7.418 kHz 8-bit Mono .5 MB Sounds like a bad 
telephone connection.
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Make QT Movie

Creates a QuickTime movie out of your project, using the compression scheme set 
through the QT Compression dialog box from the Options... sub-menu on the 
Output Menu. Refer to Table 6-1, “Comparing QuickTime Compression 
Schemes,” on page 103 to evaluate which compression mechanisms would be best 
suited for your particular project.

Make QT Special

There are two types of QT special movies that should be used under specific 
circumstances only. They are Sprite movies and GX movies.

Sprite Movie 

Sprite movie are basically a movie where instead of compressing each frame, the 
objects are stored as separate images at the beginning of the movie, and only 
different positions are stored in the following frames. The conglomeration of many 
sprite movies are used to create larger productions. Following are some caveats 
about sprite movies:

• Must be played back through QuickTime 2.1 (or later) only.

• Could be smaller than a standard QuickTime movie, depending on the number 
of objects and the duration of the animation.

• Supports scale, position and visibility changes.

• Does not support rotational changes, nore changes of the appearances of the 
objects (for example, font changes).

To create a sprite movie, select the Sprite Movie command from the Make QT 
Special sub-menu of the Output Menu.

GX Movie

A GX movie is a movie that uses a GX codec, and keeps all images in vector 
format. This type of movie is efficient if your animation is made up of all GX 
objects; otherwise the following significant caveats follow:
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• GX must be installed for playback.

• Non-GX objects (i.e., bitmap images) included in the animation will not get 
compressed, thus, potentially causing a very large movie to be created if 
bitmap images exist.

However, if you have an almost predominately GX-based project, this type of 
movie offers the best quality and compression for this specific scenario.

Make Animated GIF... 

An animated GIF... is a very popular output option because of its typically low 
overhead and easily pleadable into websites. Before creating an animated GIF, 
however, review the options that can be customly set through the GIF... command 
from the Options... sub-menu on the Output Menu. 

Make Java Animation... 

Making a Java animation of your project is to clearly reduce the strength of your 
project that you built with ObjectDANCER. Said differently, many affects offered 
by ObjectDANCER are not offered by Java, so these affects are lost when you select 
the Make Java Animation... command. Examples of lost attributes are rotation, 
transparency, transfer modes, and skewing, and most importantly, audio; although 
all of these affects are lost in a Java animation, time synchronization could be 
respected. 

Upon selecting the Make Java Animation... command, an HTML file, a sprites 
folder (including GIF files for each object), an image folder (including animation 
description files for each object), and a Java classes folder is created (compiled 
JAVA code for performing the playback of the ObjectDANCER code). Additional 
JAVA options can also be customly set through the JAVA... command from the 
Options... sub-menu on the Output Menu. 
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Printing

The Printing options are fairly straight forward, and probably even familiar to you, 
since they are the standard Print options associated with most applications. If this 
is your first time printing with QuickDraw GX, however, you will notice some 
changes in the dialog boxes, compared with what you may be used to. 

Page Setup    This command utilizes QuickDraw GX options to establish the 
desired page layout for printing your document. The “Paper Type” pull-down bar 
lists a number of different paper size alternatives, and the Format for: pull-down 
bar lists different printer types to choose from.

Print... (zP)    This command prints the current view of your project utilizing 
QuickDraw GX printing options. A dialog box appears with the name of your 
printer in the Print to: field.

If you click on the More Choices button, you get an extended dialog box offering 
more choices regarding how and when to print your document. 

With QuickDraw GX, your printing options are expanded in a number of ways. 
You have the ability to create PDD (portable digital document) files with the PDD 
Maker. PDD files are similar to PostScript files, whereby all page formats, colors, 
fonts, and graphics are retained, except that with a PDD file, you can view these 
documents on-line by just double clicking on the document icon (assuming that 
QuickDraw GX is also installed on the viewing machine).To create a PDD file, 
select PDD Maker from the Print To: pull-down bar from within the General 
window.

PostScript files can also be created with QuickDraw GX printing utilities. To 
create a PostScript file, select PostScript from the Destination: pull-down bar 
from within the General window.

The N-Up Printing window allows you print multiple pages on a single sheet of 
paper. By selecting from the Pages per Sheet: pull-down bar, you can select 
between 1, 2, 4, 6, 9, 12, or 16 pages per sheet.

The Print Time window allows you to designate a specific time and alerts for 
printing the document by tagging the appropriate flag.The Paper Match window 
offers you some options regarding paper types. Select the paper match 
requirements that meet your project needs.
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Appendix A l

Keystroke
Commands

Given the depth of ObjectDANCER’s editing capabilities, it goes without saying 
how valuable keystroke commands become eventually. Hopefully you will find the 
following keystroke commands to be as helpful and time-saving as they became 
for us during development. 

Compo Window

• Duplicate any object by [option] drag

• Move selected object(s) 10-pixel(s) by 10-pixel(s) using keyboard [shift] 
arrows (not numeric pad)

• Constrain rotation and skew using [shift] key

• Set background color by clicking on background with bucket tool

• Zoom in Compo Window using z + or z [space bar] keys

• Zoom out Compo Window using z - or z [option] [space bar] keys

• Scale Compo Window to 100% using z = keys

• Fit composition into Compo Window drawing window size box with 
[option] key
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• Quick move with hand tool by pressing [space bar] (move Compo Window 
or timeline)

• Shuffle object back using z [ keys

• Shuffle object forward using z ] keys

• Move object anchor point using [option]

• Rotate or skew object(s) around anchor point using [option] key

• Add (remove) bezier point on a path using [option] click with regular arrow 
tool

• Convert path bezier point by click (or click drag) on it using convert tool

Synchro Window

• Stretch proportionally keyframes while changing object lifespan using 
[option]

• Right or left align keyframes while changing object lifespan using [control] 
key

• Quick move hand tool pressing [space bar] key (move synchro or timeline)

• Zoom in timeline using z + or z [space bar] keys

• Zoom out timeline using z - or z [option] [space bar] keys

• Move current time frame by frame using left and right arrow keys

• Move current time to beginning (end) of the project using z left (right) 
arrow keys

• Select previous (next) object using [shift] and up (down) arrow keys to add 
selection

• Duplicate object by [option] drag the object name

• Duplicate keyframe(s) by [option] drag

• Listen to a sound by [option] clicking anywhere on sound wave object 
representation

• Launch sound window by double-clicking on sound wave object 
representation
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• Edit object name by double-clicking on object name

• Display reduced dance attributes list by click and wait on the open/close 
arrow

• Open (close) all dance attributes lists by [option] open (close) any dance list

• Apply an object dance(s) to another object(s) by drag and drop

• Add or remove objects one by one to a selection using [shift]

• Launch speed variation editor by double-clicking between two keyframes

Timeline-Related

• Edit marker name by double-clicking on it

• Erase markers by dragging them out of the timeline

• Quick move hand tool using [space bar] key

• Adjust yellow output area in and out by double-clicking on gray timeline 
rail

• Start wireframe preview of animation by dragging the current time

• Zoom in timeline using z + or z [space bar] keys

• Zoom out timeline using z - or z [option] [space bar] keys

• Set the current time to five previous or next markers position by hitting 
the last figure using numeric pad. For example, suppose you have markers: 1, 
2, 3, 4,....52, 53, 54..... Normally, to skip the current time to a marker, you 
type in a single digit marker number (i.e., 1 - 9) in the numeric keypad, and 
the current time skips to that marker. If you have a double digit marker 
number to skip to, you need to move the current time to a a close by marker 
first. So if the current time is at marker 53, and you type in 6 through the 
numeric keypad, the current time will jump to 56.

Tool Palette

With either the Compo or Synchro Window active, you can quickly select desired 
tools from the Tool palette selections by pressing the following keys:
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• h key for hand tool

• a key for arrow tool

• t key for text tool

• m key for magnify tool

• r key for rotation tool

• s key for scale tool

• k key for sKew tool

• b key for bucket tool

• e key for eyedropper tool

Other Tool palette keystroke commands are as follows:

• Switch any tool with the arrow tool by pressing z key

• Fit composition in Compo Window by double-clicking on hand tool

• Set scale of Compo Window to 100% by double-clicking on magnify tool

• Switch eyedropper tool with bucket tool using [option] key

• Switch rotation tool with scale tool using z key

• Switch skew tool with arrow tool using z key

Library

The Library keystroke commands assume that you already have an open library 
catalog displayed within the Hub window. They are as follows:

• Select previous (next) object using up (down) arrow key

• Select multiple objects in continuous range using [shift] key

• Select (or deselect) objects in a non-continuous range using z key

• Edit object name by double-clicking on object name

• Delete library catalog entry using [delete] key or zx keys

• Rearrange order of library objects by dragging an object entry up or down 
within library catalog
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Sound Window

• Place sound markers on the fly by pressing the [space bar] key while audio 
is playing

• Adjust scrubbing loop duration using [shift] drag directly in the sound wave

• Quick move hand tool pressing [space bar] key

• Zoom in timeline using z [space bar] keys

• Zoom out timeline using z [option] [space bar] keys

Miscellaneous

• Make QuickTime movie pressing [enter] key (i.e., on the numeric keypad)

• Make wireframe preview of animation pressing z and [enter] key (i.e., on 
the numeric pad)

• Extract palette info (object, text and timing) by dragging their generic icon 
at the top of Hub window onto your desktop

• Switch active window from Compo Window to Synchro Window using
z [tab] keys
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A

add bezier point cursor 76

Adobe multiple font master 
attributes 60

AIFF (Audio Interchange File For-
mat) files 92

digital vs. MIDI files 93

alpha channel 58
Over 57

anchor point 53

Animation codec 103

antialiasing 24

Arrange Menu 21

arrow tools.  See  editing tool and 
bezier points—tools

attributes 53–61
audio 60

balance 61
volume 60

common, text and graphics 53–
58

anchor point 53
color 58
opacity 54

position 53
rotation 53
scale 53
skew 53
transfer ink modes 54–58
visibility 53

text 58–60
color 58
font family 58
font size 58
GX typography 60
layout flush 59
layout justification 59
modifying through Type 

Menu 70
multiple font master 60
text area 59
tracking 60

Audio CD Window ??–112
channels pop-up 111

audio files
storage requirements 112
supported types 92

Audio Marking Windows 94–99
digital files vs. MIDI files 94
illustrated 95

audio object attributes 60
in expanded Synchro Window 39
Show Object Attributes 

command 42, 43
Also see attributes—audio

audio output bar
in Audio Marking Windows 95, 

97

audio settings
sample rate pop-up 111
sample size pop-up 111

auto-scroll, horizontal
in Audio Marking Windows 95, 

99

B

Background Color... command 71
smart icon 38

balance 61

bezier points
adding points (curves) 76
bezier tangent endpoints 76
converting angle to curve 79
converting curve to angle 78
deleting 78

Index
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manipulating 76
multiple points along a single 

path 77
speed between key frames 85
splitting a bezier tangent 79
tools

add bezier tool 76
convert bezier tool 79
delete bezier tool 78
in Toolbox Palette 51

C

CD-ROM drive 10

channels
affects storage requirements 111
in Audio CD Window 111
stereo vs. mono 111

Cinepak codec 104

Clear command 68

color 58

color picker window
HSL 73
RGB 72
 Also see color sample box, HSL, 

and RGB

color sample box 52

compile movies
GX Movie command 113
Make Animated GIF... 

command 114
Make Java Animation... 

command 114
Make QT Movie command 113
Sprite Movie command 113

Compo Window
basic illustration 19
build window 31
Compo Windows command 40
introduction to 17
positioning on desktop 25

Compo Windows command 40

Component Video (YUV) codec 104

control buttons
in Audio Marking Windows 95, 

98

convert bezier point cursor 78

Copy command 68
copy and paste objects 66

current time
in Audio Marking Windows 95
in Compo/Synchro Windows 31

current time snap buttons
in Compo/Synchro Windows 31, 

34

cursor position
in Compo/Synchro Windows 31, 

32
in Speed Variation Window 86

cursor time
in Audio Marking Windows 95, 

96
in Speed Variation Window 86

Cut command 68

D

dance bars
adjusting speed between key 

frames 86
in expanded Synchro Window 39
that extend beyond view area 90

Dancer
6-step animation 12
Compo Window 17
installation 11
Synchro Window 17

dancing attributes lists
in expanded Synchro Window 39
Also see attributes

delete bezier point cursor 78

digital audio 92
digital vs. MIDI files 93
storage requirements 112

display mode units
in Compo/Synchro Windows 31, 

34, 38

E

Edit Menu
described 20

editing tool 51

eyedropper tool 52

F

File Menu
described 20

File Sharing
turning off for Dancer 8

first/last frame buttons 31, 34

font
family

default 22
in Type Menu 71
text attribute 58

justify
in Type Menu 71

size
default 22
in Type Menu 71
text attribite 58

style
in Type Menu 71

G

GIF... command
smart icon 38, 106

Graphics codec 104

graphics object attributes
in expanded Synchro Window 39
Show Object Attributes 

command 42, 43
Also see attributes

Graphics/Sound Palette
illustrated 41
positioning on desktop 25

GX Movie command 113

GX typography attributes 60

H

hand tool 50
expanding/shortening object 

lifespans 36
moving object lifespans left or 

right 35
to scroll Synchro Window 90

hard drive
diagnostics and repair 8
partitioning for Dancer projects 8

HSL 72
color picker window 73

Hub
advantages of 41
Hub editing vs. Synchro Window 

editing 41
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illustrated 41
palettes vs. windows 41
positioning on desktop 25
Show Hub command 40

I

Import command. See objects—
importing

importing
copy and paste 66
drag and drop 65
Import command 66
imported file embedded 

preference 23
renaming imported objects 66

IN/OUT adjustment handles
in Audio Marking Windows 95, 

97
in Compo/Synchro Windows 31, 

33

incremental window sizer 31, 36

info labels
in Hub 41
in Synchro Window 31

ink modes. See transfer ink modes

J

Java. See Make Java Animation... 
command

JPEG. See Photo-JPEG (YUV) 
codec

K

key frame “mushrooms”
in expanded Synchro Window 39

key frame tags 36
in expanded Synchro Window 39
in Synchro Window 31

key frames 39
creating 39
duplicating 84
in Speed Window 85
locked, adjust left/right 84
moving location of 83
outside of object lifespan 84
relation to RCT indicator 33
speed between 85

L

layout flush 59

layout justification 59

Library Window 43–50
adding new entries 47
creating library catalogs 45
deleting entries 49
entry types

dance(s) only 44
DOBs (dancing objects) 44
raw 44

illustrated 41
importing entries into project 48
library management 

commands 46
naming a new catalog 46
renaming entries 49
Show Library command 50

loop button
in Audio Marking Windows 95, 

98

M

Make Animated GIF... 
command 114

smart icon 37

Make Java Movie... command 114

Make QT Movie command 113
smart icon 37

MIDI files 92
digital vs. MIDI files 93

MIDI track edit button
in MIDI Audio Marking 

Window 95

O

Object Attributes Palette 42, 43
compared with graphics/audio 

attributes lists (Synchro 
Window) 42, 43

Show Object Attributes 
command 42, 43

object icons 31, 35

object labels 20, 30, 31, 35

object lifespans 20, 30, 31, 35
default setting 22
that extend beyond view area 90

time alignment 87

objects
attributes

common, text and 
graphics 53–58

sound 60
text 58–60

importing 63
copy and paste 66
drag and drop 65
Import command 66
imported file embedded 

preference 23
position in Synchro Window 30
speed between key frames 85
stacking 69
supported

audio 92
graphics 31
movies 31
text 31

synchronizing with audio 92
visual alignment 90

opacity 54

Output Menu
described 21

P

paint bucket tool 52

Paste command 68
copy and paste objects 66
Also see Paste Special... command

Paste Special... command 80
key frame alignment settings 81

pause button. See play/pause button

Photo-JPEG codec 104

play/pause button
in Audio Marking Windows 95, 

98

position 53

Preferences
Input settings

default font 22
default font size 22
default object lifespan 22
default text area 22
imported file embedded 23

Output settings
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output antialiasing 24
output QuickTime size 24

Project settings
Undo level 23

setting up before working 21

project output bar 20, 30, 31, 33

Q

QT Compression command
smart icon 38

QuickDraw GX
GX Movie command 113
multiple font master 9
required for Dancer 9

QuickTime
compression 102–106

comparing codecs 103
Make QT Movie command 113
Musical Instruments 10
Power Plug system extension 10
required for Dancer 10

R

RAM
allocating to Dancer 7
Memory control panel settings 7
minimum requirements 7

RCT indicator 31, 32
dragging to see wireframe 

preview 33

Redo command 68
Also see Undo level

Revert command 26

RGB 72
color picker window 72

rotate tool 52

rotation 53

S

sample rate 111
storage requirements 111

sample size 111
8-bit vs. 16-bit 111
storage requirements 111

sampling sequences
in Audio Marking Windows 95

Save A Copy As command 26

Save As... command 26

Save Compo as GIF... command 27

Save Compo as GX... command 26

Save Compo as PICT... 
command 27

Save... command 26

scale 53

scale tool 52

scrubbing audio
in Digital Audio Marking 

Window 95

scrubbing button
in Digital Audio Marking 

Window 99

Send to Back command 69

Send to Front command 69

Show Hub command 40

Show Library command 50

Show Object Attributes 
command 42, 43

Show Preview command 21
smart icon 37

Show Text Attributes command 52

Shuffle Back command 69
smart icon 37

Shuffle Forward command 69
smart icon 37

skew 53

skew tool 52

smart icons
Center RCT Line 38
Display Mode Unit Settings 38
FPS Timeline Unit Settings 38
GIF Output Options 38, 106
Make Animated GIF 37
Make QuickTime Movie 37
QuickTime Output Options 38
Set Background Color 38
Show Preview 37
Show Timing Markers 37
Shuffle Back 37
shuffle forward object(s) 37
Text Decompose 37
Time Alignment 38

snap play/current time
in Audio Marking Windows 98

snap play/current time button
in Audio Marking Windows 95

snap/drag loop button
in Audio Marking Windows 95, 

99

Sound Manager
required for Dancer 8

sound marker maker
in Audio Marking Windows 95, 

96

sound object attributes. See audio 
object attributes

Speed Variation Window 85
controlling the speed 86

Sprite Movie command 113

stop button
in Audio Marking Windows 95, 

98

Synchro Window
basic illustration 19
expanded illustration 39
introduction to 17
positioning on desktop 25
Synchro Windows command 40

Synchro Windows command 40

system configuration
CD-ROM drive 10
File Sharing 8
hard drive 8
headphones 11
monitor 10
PowerPC 6
QuickDraw GX 11
QuickTime 10
RAM 7
Sound Manager 8
stereo speakers 11

T

text area 59
default 22

Text Attributes Palette 42
compared with text attributes lists 

(Synchro Window) 42

Text Decompose... command
smart icon 37

text object attributes
in expanded Synchro Window 39



 Index 127

Also see attributes—audio

Text Palette
illustrated 41
positioning on desktop 25
Show Text Attributes 

command 52

text tool 51

Text Ungroup command 82
centered new anchor points 

setting 82

Time alignment
align ends

free 88
locked 88

align starts
free 88
locked 88

command, described 87
elements selected 89
key frame justification settings 88
overlap 89

Time Alignment...
smart icon to launch window 38

timeline ruler 20, 31

timeline zoom tool 31, 36

timing marker maker 31, 34

Timing Palette
illustrated 41
positioning on desktop 25

Toolbox Palette
bezier point tools 51
color sample box 52
editing tool 51
eyedropper tool 52
hand tool 50
paint bucket tool 52
rotate tool 52
scale tools 52
skew tool 52
text tool 51
zoom toggle tools 51

tracking 60

transfer ink modes 54–58
And 56
Exclude 57
Fade 58
Highlight 55
Migrate 55
Opaque 54

Or 56
Over 57
Overprint RGB 54
Ramp And 56
Ramp Or 57
Revert 57
Straight Alpha 57
Tinted Glass 55
Tinted Light 55
Translucent 55
Xor 56

transfer modes. See transfer ink 
modes

Type Menu
described 21

U

Undo command 23, 68
Also see Undo level

V

Video codec 104

view setting 31, 36

visibility 53

Visual Alignment command 90

volume (as audio attribute) 60

W

WAV files 92
digital vs. MIDI files 93

window grow box 31, 36

Windows Menu
described 21

wireframe preview 33

Y

YUV. See  Component Video (YUV) 
codec

Z

zoom toggle tools 51

zoom tool. See timeline zoom tool


